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ABSTRACT 
 
 
 

ANALYSIS OF INDUCED VIBRATIONS IN FULLY-DEVELOPED  

TURBULENT PIPE FLOW USING A COUPLED  

LES AND FEA APPROACH 

 
 
 

Thomas P. Shurtz 

Department of Mechanical Engineering 

Master of Science 
 
 
 

Turbulent flow induced pipe vibration is a phenomenon that has been observed but 

not fully characterized.  This thesis presents research involving numerical simulations 

that have been used to characterize pipe vibration resulting from fully developed 

turbulent flow.  The vibration levels as indicated by: pipe surface displacement, velocity, 

and acceleration are characterized in terms of the parameters that exert influence.  The 

influences of geometric and material properties of the pipe are investigated for pipe 

thickness in the range 1 to 8 mm at a diameter of 0.1015 m.  The effects of pipe elastic 

modulus are explored from 3 to 200 GPa.  The range of pipe densities investigated is 

3,000 to 12,000 kg/m3.  All pipe parameters are varied for both a short pipe (length to 

diameter ratio = 3) and a long pipe (length to diameter ratio = 24).  Further, the effects of  



 

  



 

varying flow velocity, fluid density and fluid viscosity are also explored for Reynolds 

numbers ranging from 9.1x104 to 1.14x106.  A large eddy simulation fluid model has 

been coupled with a finite element structural model to simulate the fluid structure 

interaction using both one-way and two-way coupled techniques.  The results indicate a 

strong, nearly quadratic dependence of pipe wall acceleration on average fluid velocity.  

This relationship has also been verified in experimental investigations of pipe vibration.  

The results also indicate the pipe wall acceleration is inversely dependant on wall 

thickness and has a power-law type dependence on several other variables. The short pipe 

and long pipe models exhibit fundamentally different behavior.  The short pipe is not 

sensitive to dynamic effects and responds primarily through shell modes of vibration.  

The long pipe is influenced by dynamic effects and responds through bending modes.  

Dependencies on the investigated variables have been non-dimensionalized and 

assembled to develop a functional relationship that characterizes turbulence induced pipe 

vibration in terms of the relevant parameters.  The functional relationships are presented 

for both the long and short pipe models.  The functional relationships can be used in 

applications including non-intrusive flow measurement techniques. These findings also 

have applications in developing design tools in pipe systems where vibration is a 

problem. 
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1 

1 Introduction 

1.1 Problem Statement 

Flow induced pipe vibration is a phenomenon that is readily observed in almost any 

pipe system that involves fluid motion.  There are several possible sources of unsteady 

loading on pipe surfaces.  Some of these include vortex shedding, turbulence, cavitation, 

pulsating flow, and two-phase sloshing.  The result of this unsteady loading is dynamic 

deformation of the pipe wall.  This thesis focuses specifically on the topic of pipe 

vibration caused by turbulent fluid flow through the pipe.  While this type of flow 

induced vibration is easily observed and has been the subject of some investigation and 

research, the phenomenon has not been well characterized.  In industrial applications 

vibration can result in fatigue failure of pipe systems requiring costly maintenance and 

repairs [1].  With a more complete understanding of how pipe vibration is related to other 

variables, design tools for vibration resistant systems could be developed.  Non-intrusive 

flow measurement techniques relying on vibration measurements could also be improved 

with a set of functional relationships tying vibration level and flow rate to other important 

variables [2]. 

Several of the variables that exert influence have been explored by other researchers 

and are described briefly in chapter 2 [3-13].  Analytical, experimental, and numerical 
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research efforts in this field have been able to identify some basic relationships 

describing the dependence of pipe vibration level on flow parameters and pipe geometry 

such as average flow velocity and pipe diameter [6, 7, 11].  Each of the research 

approaches has inherent limitations and advantages, but none have resulted in a clear or 

complete picture or set of relations that describe pipe vibration in terms of the many 

influential parameters. 

Analytical approaches allow precise functional relationships to be determined 

quickly, and do not require any expensive equipment.  Most analytical models of fluid 

carrying pipes such as those introduced by Païdoussis [6] are limited to exploring average 

flow quantities only.  Because of the complexity of the governing equations describing 

fluid flow, analytical solutions are impossible for all but the simplest cases.  While the 

cylindrical geometry of pipes is simple enough for analytical solutions when the flow is 

restricted to the laminar regime, the unsteady and chaotic nature of turbulent flow renders 

the equations intractable.  Analytical approaches tend to focus on mathematical 

representations of the pipe structure, and only account for average pressure and wall 

shear stress in the fluid. 

Experimental efforts to create and measure turbulent flow induced vibrating pipe 

systems provide results with direct application to industry, but can be time consuming 

and expensive.  They are also limited by the available pipe materials and fluids, making 

controlled variation of parameters difficult.  It is also often impossible to isolate one 

particular variable without affecting others.  Experimental systems are susceptible to 

vibration from other sources, such as pump or valve noise, or entire facility vibration 
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from traffic or machinery.  Previous results from experiments such as those performed by 

Evans [7] are valuable for comparison, but are certainly limited in coverage. 

Numerical efforts at modeling a coupled system that includes time accurate 

turbulent fluid flow and dynamic pipe response have had some success, but have 

generally been limited by available computational power [11].  Limitations on processor 

speed, system memory, and storage capacity have made numerical techniques useful only 

for simple geometries and low Reynolds numbers.  While recent advances in computer 

technology have expanded the range of usefulness for these techniques, they have not yet 

been applied to developing a complete set of functional relationships that characterize 

pipe vibration caused by fully developed turbulent flow. 

1.2 Objective 

The objective of this work is to provide a more complete characterization of fully 

developed turbulent flow induced pipe vibration than currently exists.  The functional 

relationships that characterize the phenomenon are determined using a numerical model 

coupling turbulent fluid flow with a dynamic pipe structure.  The model uses a 

combination of large eddy simulation (LES) to solve for the time varying pressure field in 

the fluid domain, and finite element analysis (FEA) to solve for the transient structural 

response of the pipe.  The effects of the most influential variables are explored by 

independently adjusting each.  The final goal of the research is to assemble a set of 

functional relationships that can be used as a design tool, and with further application in 

improving non-intrusive flow measurement techniques.  An additional objective is to 

develop a methodology which can be used for additional exploration of complex variable 
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interactions so the functional relationships can continually be expanded and improved.  

Finally the resultant functional relationships will be applied to experimental data in an 

attempt to improve understanding of the physical interactions present in vibrating pipes. 

1.3 Scope 

The stated objectives will be reached by establishing a LES flow simulation in 

ANSYS® CFX® and obtaining flow solutions at seven different Reynolds numbers.  The 

transient pressure on the wall will be used to excite the FEA structural model to explore 

the structural variables.  Two classes of pipes characterized by different aspect ratios will 

be modeled.  A short pipe having length to diameter ratio (𝐿𝐿/𝐷𝐷) of 3 will be compared to 

a long pipe having 𝐿𝐿/𝐷𝐷 = 24.  Both the long pipe and the short pipe models will be used 

to explore the effects of pipe elastic modulus, pipe density, wall thickness, inside pipe 

diameter, and user specified damping ratio in the modeling scheme.  The range of 

variables explored is shown in Table 1-1.  A set of non-dimensional variables will be 

created that includes all of the explored variables listed in addition to the dependant 

variables 𝛿𝛿′, 𝑉𝑉′, and 𝐴𝐴′, which indicate the standard deviation of the pipe wall deflection, 

pipe wall speed, and pipe wall acceleration, respectively.  A set of functional 

relationships for the non-dimensional variables will then be determined. 

1.4 Overview 

Chapter 2 of this thesis contains a review of the literature relevant to the topic of 

turbulent flow induced pipe vibration.  Previous work and contributions from other 
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researchers in this area are discussed to determine the current state of this field of 

research.  Specific contributions and delimitations of this work are discussed in the 

 

Table 1-1 Values of variables explored 

Variable Values Explored Units 

 Long Pipe (L/D = 24) Short Pipe (L/D = 3)  
Pipe Elastic 

Modulus 2, 3.7, 10, 20, 40, 70, 200 3.7, 6, 12, 25, 50, 100, 200 GPa 

Pipe Density 1, 1.3, 2, 3, 4, 5, 6, 7, 8 1, 1.3, 2, 3, 4, 5, 6, 7, 8 1000 kg/m3 

Pipe Wall 
Thickness 1, 2, 3, 4, 5, 6, 7, 8 1, 2, 3, 4, 5, 6 mm 

Pipe Material 
Damping 0.01, 0.05, 0.1, 0.5, 1, 5 0.01, 0.05, 0.1, 0.5, 1, 5 s 

Reynolds 
Number 0.9, 1, 2, 3.4, 4.6, 6, 8, 11 0.9, 1, 2, 3.4, 4.6, 6, 8, 11 100,000 

 

 

context of the existing literature.  Chapter 3 presents the methodology used to model the 

fluid domain using LES, such that others may reproduce the author’s work.  The fluid 

model is verified and validated, such that its use for the intended purpose can be justified.  

Chapter 4 discusses the structural FEA model.  Again, the method of generating the 

model is discussed along with verification and validation studies.  Chapter 5 is devoted to 

an explanation of the procedures used to couple the fluid and structural models.  Chapter 

6 presents the results obtained from solving the coupled model using the full range of 

variables.  The results are also compared to those obtained from experimental work.  

Chapter 7 details the conclusions drawn from the research and concludes the body of the 

thesis.  Finally, the references used in this thesis are listed, and applicable appendices are 

included.  
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2 Background 

Turbulent flow induced pipe vibration as a special application of fluid structure 

interaction (FSI) has been the subject of some attention, particularly as increasing 

computing power makes numerical approaches possible.  This phenomenon has been 

explored using analytical and experimental techniques as well.  This chapter reviews the 

available literature summarizing previous research efforts aimed at improving 

understanding of flow induced pipe vibration. 

2.1 Analytical Models 

One approach to determining the effects of important variables on pipe vibration is 

to solve a mathematical model of the pipe structure analytically.  This generally involves 

making simplifying assumptions to allow the equations representing the system of 

interest to be solved.  Most work in this area has focused on either response to a flowing 

inviscid fluid, or response variation due to pre-stressing caused by internal pressure and 

wall shear. The first method assumes a moving, inviscid fluid that affects the propagation 

of waves along the pipe material.  Païdoussis [6] gives the linear equations of motion for 

a pipe represented as either a beam or a cylindrical shell.  The beam model assumes plug 

flow for the fluid while the shell model uses inviscid potential flow theory.  While both 

models have the interesting result that the pipe will be unstable and subject to vibration 
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above a critical flow velocity, neither considers turbulent fluctuations as the source of 

vibration.  Xu and Yang [14] explain that previous models are not accurate near the 

critical velocity which causes pipe instability.  They then expand on this type of approach 

to allow it to be more effective when the fluid velocity approaches the critical value.  

They use an Euler-Bernoulli model pipe containing fluid and develop a non-linear 

equation of motion.  They apply the Newtonian method and use an order of magnitude 

analysis to simplify the equations.  The primary goal of their studies was to determine the 

relative magnitude of internal resonances and at which fluid velocities they are excited.  

Again, potential flow theory is used and turbulent flow is not considered. 

Additional efforts by Bochkarev and Matveenko [10] examine the added effects of 

varying boundary conditions at the pipe ends.  Vassilev and Djondjorov [5] added a 

foundation along the pipe to represent periodic non-rigid supports.  They allow the 

foundation stiffness to vary to simulate different spacing or types of supports.  Both 

models used by Bochkarev and Matveenko and Vassilev and Djondjorov became too 

complex to use a strictly analytic solution procedure and employ numerical techniques.  

Any attempts to include distributed loading such as one would expect for turbulent wall 

pressures have required numerical techniques as well.  Further discussion of approaches 

including distributed loading will therefore be saved for the numerical techniques section 

of this chapter. 

2.2 Experimental Investigations 

Measuring pipe vibration experimentally does not require any simplifying 

assumptions.  While no modeling is done, the experimenter is limited to the use of 
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available fluids and pipe materials.  Also, the difficulty of isolating the vibration to that 

caused by fully developed turbulence presents itself.   

Early work by Weyers [8] was done to determine how acoustic noise radiated from 

a pipe was affected by average flow speed in the pipe.  The pipe wall in this case was 

very thin and the only measurement taken on the pipe wall was with a pressure 

transducer.  This was done to attempt to estimate the pressure fluctuations within the 

pipe.  The estimated pressure fluctuations were found to scale approximately with mean 

centerline velocity squared (𝑈𝑈2).  The root mean square (RMS) of the externally radiated 

acoustic pressure was found to scale with 𝑈𝑈2.5.  Although these results were hypothesized 

to relate to pipe wall vibration, no direct vibration measurements were made.  Saito, et al. 

made specific vibration measurements on the pipe wall [15].  They quantified pipe wall 

acceleration (𝐴𝐴𝑅𝑅𝑅𝑅𝑅𝑅 ) in terms of mean fluid velocity. The source of vibration was 

identified as being turbulence related, although it was not isolated as fully developed 

turbulence because of the presence of an orifice plate near the measurement location.   

Similar work by Evans [7] was done to demine the feasibility of using pipe 

vibration levels as an indicator of flow rate through the pipe.  His work was based on the 

premise that pipe wall fluctuations indicated by the standard deviation of acceleration 

(𝐴𝐴′) would be proportional to the standard deviation of the pressure at the wall (𝑃𝑃′).  It 

was further assumed that the pressure fluctuations would in turn be a function of the flow 

rate, 𝑄𝑄.  Evans experiments indicated a nearly quadratic relationship between flow rate 

and 𝐴𝐴′ where the proportionality is indicated as 𝐴𝐴′ ∝  𝑄𝑄2.  Other investigations included 

the use of other pipe sizes and materials.  Evans’ work used two pipe diameters (0.076 m 

and 0.102 m nominal) and three pipe materials (PVC, aluminum, and stainless steel).  
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Although he was able to show that both diameter and pipe material influence the pipe 

vibration level, it is difficult to determine any well defined functional relationship with so 

little data.  In this case the working fluid was always water, and the flow rate was varied 

by controlling the speed of a pump.  Evans indicates that the data was filtered to remove 

frequency content in the range likely to be caused by pump noise, but no explanation is 

given of how this was determined.  Because of the inclusion of a pump, and the bends 

and other geometry changes in the experimental setup, the source of vibration was not 

isolated to that induced by fully developed turbulent flow. 

Durant and Robert made direct measurements of pipe wall vibration using 

accelerometers [16] and a laser vibrometer [4].  In addition, he measured the wall 

pressure fluctuations of air flow through a pipe.  The acoustic fluctuations due to pressure 

wave reflection were filtered out and the cross spectra were used to create a wall pressure 

model in terms of convection velocity and correlation length.  In these studies the object 

was to measure spectra and acoustic radiation rather than vibration amplitude.  Only a 

single pipe and working fluid were used. 

2.3 Numerical Approaches 

Many numerical approaches to characterizing flow induced pipe vibration have 

focused on solving the structural pipe model while including approximations for the flow 

field.  The research of Seo, et al. involves the use of time variable velocity, but applies 

potential flow theory like the analytical approaches [17].  In their studies, the bulk 

velocity was allowed to vary harmonically, but did not have the local and chaotic 

fluctuations characteristic of turbulent flow.  Numerical techniques were then applied to 
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solve the equation for motion of the pipe.  They were able to show that with a pulsating 

fluid, pipe instability and vibration can occur at velocities lower than the critical velocity 

indicated in the analytical studies done by those like Païdoussis [6]. 

Applying distributed loading to the surface of the structural pipe model allows local 

turbulent fluctuations to be accounted for.  In these models the pipe surface is given a 

temporally and spatially varying pressure load.  Durant, et al. used numerical methods to 

solve a model including a cross-spectral representative pressure field integrated over the 

pipe wall [4].  The cross spectra were generated using experimental pressure 

measurements and a Corcos model.  The purpose of their work was to compare frequency 

content of radiated acoustic pressure with experiment.  The numerical model showed 

agreement within a few decibels of experimental measurements across the frequencies of 

interest (300-3000 Hz).  Four discrete fluid velocities were used, but no attempt to 

quantify the effect of velocity on vibration level was made.  Birgersson et al. used a 

similar approach of modeling the pressure load spectrally, but apply a different type of 

numerical technique using spectral super elements for increased computational efficiency 

when solving for the pipe wall response [9].  Finnveden, et al. use the same approach as 

Durant, but use a modified Chase model for the turbulent pressure spectra.  The Chase 

model gives better results at higher frequencies [18]. 

All of the numerical efforts mentioned thus far have relied on statistical models of 

the turbulent pressure as a forcing function for various numerical representations of the 

pipe structure.  This approach makes two-way coupling of the pipe motion and pressure 

field impossible, but does allow for computational efficiency by avoiding numerical 
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modeling of the fluid domain.  Also, the focus of the researchers has been directed at 

frequency content and acoustic noise, not the pipe motion itself. 

Recent development in the field of computational fluid dynamics has made it 

possible to resolve the most significant levels of turbulence through LES.  A full LES 

model of the fluid domain was used in work by Pittard to investigate the effects of fluid 

velocity, pipe diameter and pipe material on the standard deviation of pipe wall 

acceleration [11].  His model was quite limited by computational resources available at 

the time.  The flow domain length was restricted to just over one diameter and the 

maximum Reynolds number achieved was 420,000.  The FEA model of the pipe could 

only be solved for a maximum of 50 time-steps due to a file size limitation imposed by 

the file system.  This resulted in low temporal resolution.  Even with these limitations the 

model was able to generate results that fit very well with experimental measurements.  

Pittard examined six fluid velocities in water giving Reynolds numbers in the range 

80,000 – 420,000.  He also looked at the influence of diameter for three pipe sizes from 

0.038 m – 0.102 m.  The effect of pipe modulus was considered for static deflection 

comparisons.  Because the displacements were small enough to be in the linear material 

behavior range, the deflection was exactly inversely proportional to the modulus.  

Dynamic pipe behavior was not considered in the studies performed by Pittard. 

2.4 Research Contribution   

The work presented in this thesis uses an approach very similar to that taken by 

Pittard.  Spatial and temporal variations in the fluid domain will be determined through 

the use of an LES fluid model.  This allows the problem of interest to be studied instead 
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of a simplified analytical model.  The inherent limitations present in all experimental 

work are avoided through the use of a numerical model that allows arbitrary variation in 

parameters where the effects of fully developed turbulent flow can be examined directly 

without contamination by external sources.  The model used in the research leading to 

this thesis examines a wider range of Reynolds numbers and adds additional important 

parameters not present in previous work outlined in the literature.  A fully coupled two-

way model is also used for comparison to determine if it improves or changes results.  

This work does use approximations for the small scales of turbulence due to the nature of 

the LES model.  Computational resources are still a limiting factor for LES models, and 

only a simple cylindrical flow field is considered.  Wall roughness effects are not 

included in the model, but are present in many industrial applications.  Because of the 

ideal conditions under which the model is operated, many of the results may be difficult 

to validate with experiments, and application of the results to real world scenarios must 

be done with care.  However, the results of this numerical model have been compared to 

experiments, and the comparison is presented in this thesis for validation of the model. 
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3  LES Fluid Model 

This Chapter will describe the method used to create and solve the LES model of 

the fluid domain.  An explanation of LES computational fluid dynamics (CFD) modeling 

is included in addition to the particular application used in this research.  The procedures 

are described in such a way that the reader can duplicate the construction of the model 

used to obtain the results presented in this thesis.  The ANSYS CFX program was chosen 

because it not only allows the required LES turbulence model, but it allows direct two-

way coupling with the ANSYS® Multiphysics™ structural FEA model [19].  ADINA® 

was another software package that was considered for use.  It also allows full coupling of 

the fluid and solid domain using the finite element method (FEM) for both, but it does 

not allow the periodic boundary condition required in the fluid domain for proper LES 

modeling of pipe flow.   The coupling approach is discussed in detail in a later chapter, 

but the CFD portion of the modeling is explained in this chapter.  Fluid model 

verification and validation studies are also presented in this chapter. 

3.1 LES 

The use of LES as a turbulence model is based on the concept that turbulent flows 

contain a wide range of length and time scales.  The phenomenon of turbulence can be 

described as being unsteady, three-dimensional, non-linear, and chaotic but not random.  
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Spatially coherent structures that change and develop in time are often referred to as 

eddies.  The largest eddies, having dynamic and geometric properties related to the mean 

fluid flow, contain more energy than the smallest eddies.  The LES approach makes use 

of this fact by applying spatial filters to the governing equations to remove, and therefore 

model, the smallest eddies while the large eddies are numerically simulated.  This 

approach requires less computation than direct numerical simulation (DNS) which does 

not filter the equations and resolves all scales of turbulence.  LES does take more 

computation than the commonly used Reynolds averaged Navier-Stokes (RANS) 

turbulence models, but RANS models do not resolve the turbulent pressure fluctuations 

responsible for the pipe vibration of interest.  Because the LES model provides the ability 

to resolve pressure fluctuations while allowing solutions on more modest computer 

hardware, it is the model of choice for this research.   

3.1.1 Governing Equations of Fluid Flow 

The governing equations for a constant property, incompressible fluid with no body 

forces consist of the continuity equation, represented using index notation as: 

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑖𝑖

= 0 

and the Navier-Stokes equations, also shown using index notation as: 

𝜌𝜌 �
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝑢𝑢𝑖𝑖𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑗𝑗

� = 𝜇𝜇
𝜕𝜕2𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗2

−
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑖𝑖

 

where 𝑢𝑢 is the velocity, 𝜌𝜌 is the fluid density, 𝜇𝜇 is the dynamic viscosity and 𝑃𝑃 is the 

static pressure.  Large eddy simulation (LES) filters these governing equations and 

(3-1) 

(3-2) 
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decomposes the flow variables into large scale (resolved) and a small scale (unresolved) 

parts.  Any flow variable y can be written as: 

𝑦𝑦 = 𝑦𝑦� + 𝑦𝑦′ 

where 𝑦𝑦� is the large scale part and 𝑦𝑦′ is the unresolved small scale part.  The large scale 

part is defined through volume averaging as: 

𝑦𝑦�(𝑥𝑥𝑖𝑖 , 𝑡𝑡) ≡�𝐺𝐺(𝑥𝑥𝑖𝑖 − 𝑥𝑥𝑖𝑖′)𝑦𝑦(𝑥𝑥𝑖𝑖′ , 𝑡𝑡)𝑑𝑑𝑥𝑥𝑖𝑖′ , 

where 𝐺𝐺(𝑥𝑥𝑖𝑖 − 𝑥𝑥𝑖𝑖′) is a filter function (a simple box filter is often used).  After performing 

the volume averaging, the spatially filtered Navier-Stokes equations become: 

𝜌𝜌 �
𝜕𝜕𝑢𝑢�𝑖𝑖
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝑢𝑢𝑖𝑖𝑢𝑢𝑗𝑗�����
𝜕𝜕𝑥𝑥𝑗𝑗

� = 𝜇𝜇
𝜕𝜕2𝑢𝑢�𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗2

−
𝜕𝜕𝑃𝑃�
𝜕𝜕𝑥𝑥𝑖𝑖

. 

The non linear term carries all of the complexity and can be expanded as follows: 

𝑢𝑢𝑖𝑖𝑢𝑢𝑗𝑗����� = (𝑢𝑢𝑖𝑖� + 𝑢𝑢𝑖𝑖′)(𝑢𝑢𝑗𝑗� + 𝑢𝑢𝑗𝑗′)����������������������� 

         = 𝑢𝑢𝑖𝑖�𝑢𝑢𝑗𝑗������ + 𝑢𝑢𝑖𝑖�𝑢𝑢𝑗𝑗′����� + 𝑢𝑢𝑗𝑗�𝑢𝑢𝑖𝑖′����� + 𝑢𝑢𝑖𝑖′𝑢𝑢𝑗𝑗′ .������ 

Derivations of the RANS equations use similar nomenclature, but the over-bar variables 

here are spatial averages, not temporal averages.  The second and third terms (cross 

terms) of (3-7) are identically zero after taking the derivative when averaging in time, but 

this is not true for the volume averaged quantities.  Even though the filter functions used 

by most LES models do not remove these cross terms exactly, they are considered small 

and are thus neglected even when not zero.  Introduction of the sub grid scale (SGS) 

stresses as: 

𝜏𝜏𝑖𝑖𝑖𝑖 =  𝑢𝑢𝑖𝑖′𝑢𝑢𝑗𝑗′������ − 𝑢𝑢�𝑖𝑖𝑢𝑢�𝑗𝑗����� 

allows the Navier-Stokes equations to be rewritten in a form that looks just like the  

unfiltered equations, but with an extra term as shown in (3-9): 

(3-3) 

 

(3-4) 

(3-5) 

(3-6) 

(3-7) 

(3-8) 
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(3-9) 

(3-10) 

(3-11) 

(3-12) 

(3-13) 

(3-14) 

𝜌𝜌 �
𝜕𝜕𝑢𝑢�𝑖𝑖
𝜕𝜕𝜕𝜕

+ 𝑢𝑢�𝑗𝑗
𝜕𝜕𝑢𝑢�𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

� = 𝜇𝜇
𝜕𝜕2𝑢𝑢�𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗2

−
𝜕𝜕𝑃𝑃�
𝜕𝜕𝑥𝑥𝑖𝑖

+
𝜕𝜕𝜏𝜏𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

. 

3.1.2 Smagorinsky Model 

The Smagorinsky model [20] combines the assumption of small cross terms with a 

mixing-length based eddy viscosity model for the SGS stress tensor 𝜏𝜏𝑖𝑖𝑖𝑖 .  It therefore 

assumes that the SGS stresses are proportional to the filtered strain rate tensor as shown: 

𝜏𝜏𝑖𝑖𝑖𝑖 −
1
3
𝜏𝜏𝑘𝑘𝑘𝑘𝛿𝛿𝑖𝑖𝑖𝑖 = −2

𝜇𝜇𝑆𝑆𝑆𝑆𝑆𝑆
𝜌𝜌

𝑆𝑆𝑖̅𝑖𝑖𝑖  

where 𝛿𝛿𝑖𝑖𝑖𝑖  is the Kronecker delta, 𝜇𝜇𝑆𝑆𝑆𝑆𝑆𝑆  is the sub grid scale viscosity, and the strain rate 

tensor is: 

𝑆𝑆𝑖̅𝑖𝑖𝑖 =
1
2
�
𝜕𝜕𝑢𝑢�𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢�𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

�. 

To close the equation, a model for the SGS viscosity 𝜇𝜇𝑆𝑆𝑆𝑆𝑆𝑆  is needed. Based on 

dimensional analysis, the SGS viscosity can be expressed as the product of density, a 

length scale, and a velocity scale: 

𝜇𝜇𝑆𝑆𝑆𝑆𝑆𝑆 ∝ 𝜌𝜌∆𝑞𝑞𝑆𝑆𝑆𝑆𝑆𝑆  

where  ∆ is the length scale of unresolved motion, and 𝑞𝑞𝑆𝑆𝑆𝑆𝑆𝑆  is the velocity of the 

unresolved motion.  The length scale ∆ is determined by the local grid size to be: 

∆= �𝑉𝑉𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
3  

where  𝑉𝑉𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐  is the volume of the local grid cell.  In the Smagorinsky model, based on an 

analogy to the Prandtl mixing length model, the velocity scale is related to the gradients 

of the filtered velocity through the length scale: 

𝑞𝑞𝑆𝑆𝑆𝑆𝑆𝑆 = ∆|𝑆𝑆̅| = ∆�2𝑆𝑆𝑖̅𝑖𝑖𝑖 𝑆𝑆𝑖̅𝑖𝑖𝑖 . 
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(3-15) 

(3-16) 

This finally yields the Smagorinsky model for the SGS viscosity: 

𝜇𝜇𝑆𝑆𝑆𝑆𝑆𝑆 = 𝜌𝜌(∆𝐶𝐶𝑠𝑠)2|𝑆𝑆̅| 

where 𝐶𝐶𝑠𝑠 is called the Smagorinsky constant.  It usually has values ranging between 

0.065 and 0.25 depending on the geometry and type of flow.  Accurately modeling the 

flow near walls requires an adjustment to be made to the turbulent viscosity so it can be 

forced to approach zero at the wall.  This modification procedure is called wall damping.  

The turbulent viscosity can be damped using a combination of a mixing length minimum 

function, and a viscosity damping function: 

𝜇𝜇𝑆𝑆𝑆𝑆𝑆𝑆 = min(𝜅𝜅 ∙ 𝑦𝑦𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤 ,𝑓𝑓𝑢𝑢∆𝐶𝐶𝑠𝑠)2|𝑆𝑆̅| 

where 𝜅𝜅 is the von Karmen constant, usually taken as 0.41, 𝑦𝑦𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤  is the distance to the 

wall, and 𝑓𝑓𝑢𝑢  is a damping function.  The damping function is often a constant, and the 

default value of 1.0 is used in the simulations for this research. 

3.2 Flow Physics 

The CFD model requires the definition of a discretized geometry called the mesh, 

or grid, where the solution will be calculated.  Boundary conditions must be specified, 

and flow properties defined.  Finally the solution procedure must be specified and the 

flow field initialized.  These steps constitute the defining of the flow physics and 

numerical scheme for the model. 

3.2.1 Computational Mesh 

For the model used in this research the domain is a cylinder 0.3 m long and .1015 m 

in diameter representing a section of the interior of a pipe.  Other researchers have found 
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that pipe lengths of 4/3D [11], 5D [21], and 2πD [22], where D is the diameter, produce 

adequate results.  The length of pipe chosen for these simulations is approximately 3D, or 

slightly shorter than that suggested by Eggels [21] but significantly longer than that used 

by Pittard [11].  Although Pittard justified the use of a shorter pipe, it was used primarily 

because of computational limitations that are no longer as restrictive, so the longer pipe is 

used here to increase the accuracy of the results.  Although the geometry is cylindrical, a 

Cartesian coordinate system is used placing the axis of the cylinder on the x-axis and 

placing the inlet on the yz plane.   

The domain was discretized, or meshed using ANSYS® ICEM CFD™.  This is a 

utility intended strictly for generating meshes to be used for computational fluid 

dynamics (CFD) simulations.  CFX also has meshing capabilities, but it does not give the 

user as much control or flexibility.  Specifically the ICEM program allows the use of the 

O-grid type mesh.  An O-grid type mesh is used which has a uniform square central 

region but gradually deforms to become more radial and perpendicular to the wall in the 

near wall region.  This gives superior characteristics for the cylindrical domain being 

represented.  The wall region has a slight inflation layer in the radial direction to allow 

better resolution of the high velocity gradients there.  The square central region is 60 by 

60 nodes.  The O-grid ring that transitions from the square central region to the 

cylindrical wall contains 30 radial nodes and 236 circumferential nodes.  There are 180 

nodes in the axial direction.  A view of the mesh as seen from the axial direction is shown 

in Figure 3-1.  This mesh contains a total of 1,879,920 nodes and 1,848,175 hexahedral 

elements.  The mesh contains 42,480 nodes on the wall where pressure information can 

be extracted or passed to the FEA solver in the coupling procedure.   
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Figure 3-1 End view of fluid mesh 

 

It is common to look at the mesh size in terms of dimensionless length scale 

parameters when determining how well the mesh can be expected to perform [23].  

Generally, a mesh must meet minimum length scale requirements in order to achieve a 

given degree of accuracy.  LES models require a fine mesh compared to other turbulence 
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(3-17) 

(3-18) 

(3-19) 

(3-20) 

models, and therefore require shorter minimum length scales.  The length scales are 

obtained by normalizing the grid spacing by the friction velocity and kinematic viscosity: 

𝑟𝑟+ = (𝑅𝑅 − 𝑟𝑟) 𝑢𝑢𝜏𝜏
𝜈𝜈

, 

∆𝑧𝑧+ = ∆𝑧𝑧 𝑢𝑢𝜏𝜏
𝜈𝜈

, 

𝑅𝑅∆𝜃𝜃+ = 𝑅𝑅∆𝜃𝜃 𝑢𝑢𝜏𝜏
𝜈𝜈

  

where 𝑅𝑅 is the pipe inner radius, 𝑟𝑟 is the specific radial location of interest, 𝑢𝑢𝜏𝜏  is the 

friction velocity, 𝜈𝜈 is the kinematic viscosity, ∆𝑧𝑧 is the axial grid spacing, and 𝑅𝑅∆𝜃𝜃 is the 

azimuthal grid spacing.  The friction velocity is generally not known before the 

simulation is complete, but in this case there is significant experimental data that allows 

𝑢𝑢𝜏𝜏  to be determined from the pipe friction factor through the following relation: 

𝑢𝑢𝜏𝜏 = 𝑈𝑈�
𝑓𝑓
8

 

where the Darcy friction factor 𝑓𝑓 is available from experimental data on a Moody chart, 

or though some other empirical relationship.  For the flows studied here the friction factor 

varies between about 0.018 at the lowest Reynolds number of 9.14x104, and 0.011 at the 

highest Reynolds number of 1.14x106.  Using these values to convert the mesh spacing 

gives upper and lower dimensionless grid wall resolutions as shown in Table 3-1.  Also 

shown is the dimensionless grid spacing used in studies by Pittard for comparison [11].  

The present studies use slightly better dimensionless grid resolution in the near wall 

region than the resolution found to be acceptable by Pittard. 
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Table 3-1 Dimensionless grid spacing at wall 

 𝑟𝑟+ 𝑧𝑧+ 𝑅𝑅𝑅𝑅+ 𝑟𝑟/𝑅𝑅 ∆𝑧𝑧/𝐿𝐿 ∆𝜃𝜃/2𝜋𝜋 

Present Simulations  
ReD = 1.14x106  

80 690 550 0.0038 0.0056 0.0042 

Present Simulations  
ReD = 9.1x104

 

8.5 70 57 0.0038 0.0056 0.0042 

Pittard 
ReD = 4.15x105 

279 284 284 0.015 0.012 0.015 

Pittard 
ReD = 8.3x104 

64 65 65 0.015 0.012 0.015 

 

 

Recommendations for the minimum values for LES models to be able to resolve a 

boundary layer are given by Piomelli [24].  He suggests using minimum values of 𝑟𝑟+ ≤ 1, 

𝑧𝑧+ ≈ 50-100, and  𝑅𝑅𝑅𝑅+ ≈ 15-40.  Rudman used slightly higher values but was still able to 

get results that compared well with experimental data [22].  The values for this mesh are 

too high to resolve the viscous sub-layer, but the near wall node is well into the log layer 

where most of the turbulent energy is producing fluctuations.  Although the wall is not 

well resolved, the viscous sub-layer is not of particular interest when looking at the 

turbulent pressure fluctuations. 

3.2.2 Boundary and Initial Conditions 

The cylindrical surface of the domain is defined as a solid wall with the no-slip 

condition being enforced.  Although options are available for including surface roughness 

effects, they are not used, and thus only smooth wall pipes are modeled.  The no-slip wall 

boundary condition not only forces the fluid velocity to zero here, but also initiates the 

wall damping effects on the SGS viscosity.  Also, because much of the boundary layer is 
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not resolved, a wall modeling approach is applied.  The wall model applies a synthetic 

law-of-the-wall velocity profile in the near wall region to adjust for the fact that the near 

wall node may be outside the viscous sub-layer.  This results in velocity profiles that are 

not accurate in the lowest part of the log-law region or in the viscous sub-layer, but that 

produce better results in the regions which are resolved. 

One of the difficulties in LES models is providing a proper time-varying velocity 

profile for use at the inlet.  With no prior solution available, an inlet condition with 

specified velocity cannot be used unless the domain is long enough for the flow to 

develop and for instabilities to grow and become self-sustaining.  For these simulations a 

periodic boundary is used to effectively connect the inlet and the outlet.  The only value 

specified for this type of boundary is the total mass flow rate through the boundary.  This 

condition forces the velocity and SGS properties to be matched at the inlet and outlet.  

The pressure will also be matched, but with an offset to account for viscous losses and to 

balance the drag force on the walls.  The periodic condition can be applied most easily 

when the grid at both sides of the interface is identical as is true with the grid used here.  

This allows for 1:1 matching of values at each of the nodes.  When the grids are different, 

interpolation techniques need to be used across the periodic boundary which results in 

additional computation time and additional error.  The periodic boundary will let the flow 

develop as it effectively reenters the inlet each time it has passed through the entire 

domain. 

Because LES models are by definition unsteady, proper initial conditions must be 

established for an instantaneous solution to be accurate.  Initializing LES simulations can 

be difficult for the same reason inlet conditions are not practical.  Either an existing 
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spatially correct solution must be used as an initial flow field, or the flow will need to 

develop for a long enough time to become statistically steady.  Although the 

instantaneous solution is constantly changing due to the nature of turbulence, statistical 

quantities may be constant as in fully-developed pipe flow.  The time-averaged velocity 

profile, pressure drop, and derivatives of these values will be constant when averaged 

over a long enough period of time.  The goal of the LES simulation is to reach this 

statistically steady state as quickly as possible to keep computation time to a minimum.  

One method for initializing the flow field in a way that allows it to develop into the 

statistically steady turbulent state is to use a close approximation of turbulence based on 

analysis of experimental flows.  The core region of pipe flow may be approximated by 

isotropic turbulence for initialization purposes.  In practice this is accomplished by 

superposing random fluctuations on an otherwise smooth profile.   

The random fluctuation technique is used here in combination with increasing mesh 

refinement to cut down computation time.  First, the flow is initialized using a flat 

velocity profile across the entire domain, but on a coarse mesh, and with random 

perturbations.  This solution is allowed to run until statistically steady, which takes about 

5000 time steps.  The final state of this solution is then used as the initial condition on the 

final mesh.  Approximately 2000 additional time steps are required for the solution to 

become statistically steady on the final mesh.  The final state of this solution is then used 

as the initial condition for the simulation of interest. 

3.2.3 Solver Settings 

The LES simulation used for this research was repeated eight times, each at a 

different Reynolds number.  All of the simulations used the same mesh and boundary 
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conditions.  All of the simulations also used most of the same solver settings.  The 

settings which remained consistent through all of the simulations are shown in Table 3-2. 

 

Table 3-2 Solver settings used for all simulations 

Setting Value 
Smagorinsky Constant 0.1 

Advection Scheme 2nd Order Central Difference 
Transient Scheme 2nd Order Backward Euler 

Pressure Velocity Coupling Fully Coupled 
Convergence Controls 1x10-5 RMS Momentum Residuals 

Average Courant Number 0.6 
 

 

The correct Smagorinsky constant depends on the type of flow being modeled.  

Other researchers have shown that the best results for pipe flow are obtained when using 

a value of 0.1 [22].  The solution is also not particularly sensitive to this parameter.  The 

value of 0.1 is the default in CFX and is the value used here. 

The advection scheme deals with the discretization of the governing transport 

equations.  Most CFD models will use upwind schemes when advection dominates over 

diffusion and the grid is aligned with the flow.  In LES models, however, there is 

localized swirling and velocity components in directions other than that of the bulk flow.  

The central difference scheme is recommended for use in LES models in the best 

practices guide included with CFX [19].  This avoids the numerical dissipation of the 

upwind schemes from flow not aligned with the grid.  The 2nd order central difference 

scheme is therefore selected when setting up these simulations. 
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The transient scheme determines how the portions of the governing equations 

dealing with derivatives in time are discretized.  Because the flow field at any point in 

time depends only on the past flow field, and not future events, it is possible to use 

explicit techniques that require no iteration and are therefore computationally efficient.  

The explicit techniques are only conditionally stable.  This becomes particularly 

problematic when using fine spatial discretization which might require unreasonably 

small time steps to maintain stability.  Fully implicit first order methods are too diffusive 

for use with LES and will unnaturally damp out the turbulence.  The higher order implicit 

methods work best for LES. 

CFX uses a fully coupled approach for pressure and velocity.  Segregated solvers 

employ a solution strategy where the momentum equations are first solved, using a guess 

for the pressure field, and an equation for a pressure correction is obtained.  The pressure 

field is then updated to the corrected value and the procedure is repeated. Because of the 

‘guess-and-correct' nature of the linear system, a large number of iterations are typically 

required in addition to the need for selecting appropriate relaxation parameters for the 

variables.  CFX uses a coupled solver, which solves the set of discretized equations as a 

single system. This solution approach uses a fully implicit discretization of the equations 

at any given time step.  This reduces the number of iterations required to calculate the 

solution for each time step in a transient analysis. 

Because of the iterative solution procedure required by the implicit discretized 

equations, the solutions approach a final value as the procedure progresses.  During the 

first iterations there is an imbalance in the equations that is indicated by the residuals.  

Though additional iterations, the value of the residuals decreases as the solution 
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(3-21) 

approaches completeness.  The solver determines whether the solution at a particular time 

step is complete by checking to see if the residuals are below some threshold value.  The 

default threshold value is 1x10-4, and is generally sufficient, but a more conservative 

value of 1x10-5 was used.  Keeping the time steps smaller will allow faster convergence 

and a looser convergence criteria can be used. 

The Courant number is a dimensionless parameter that indicates the relative size of 

the time step for the given mesh and flow conditions.  It is defined as: 

𝐶𝐶 = 𝑈𝑈
∆𝑡𝑡
∆𝑥𝑥

 

where 𝑈𝑈 is the fluid velocity, ∆𝑡𝑡 is the time step size, and ∆𝑥𝑥 is the grid size in the flow 

direction.  This number indicates how many grid lengths a fluid element travels each time 

step.  Smaller Courant numbers are required for stability in explicit transient schemes.  In 

LES models the Courant number should be kept small enough to require only three to 

five iterations, or coefficient loops, per time step [19], and a value between 0.5 – 1.0 is 

generally adequate.  Using a Courant number of 0.6 – 0.7 for the simulations used in this 

research allowed the solution to be converged at each time step after at most five 

iterations per step. 

In addition to the consistent solver settings, the fluid properties were kept constant 

for each simulation.  The working fluid was water with density of 997 kg/m3, and 

dynamic viscosity of 8.899x10-4 N∙s/m2.  The different Reynolds numbers were achieved 

by modifying the fluid velocity.  The time step size was also changed to keep the Courant 

number the same for each simulation.  The settings and Reynolds number for each 

simulation are shown in Table 3-3. 
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Table 3-3 Settings used to vary Reynolds number 

Reynolds Number Mass Flow Rate Average Velocity Time Step 

91,000 6.454 kg/s 0.8 m/s 1.25x10-3 s 

114,000 8.068 kg/s 1.0 m/s 1.0x10-3 s 

227,000 16.14 kg/s 2.0 m/s 5.0x10-4 s 

341,000 24.20 kg/s 3.0 m/s 3.33x10-4 s 

455,000 32.27 kg/s 4.0 m/s 2.5x10-4 s 

569,000 40.34 kg/s 5.0 m/s 2.0x10-4 s 

796,000 56.48 kg/s 7.0 m/s 1.43x10-4 s 

1,140,000 80.68 kg/s 10.0 m/s 1.0x10-4 s 

 

3.3 General Observations 

In order to ensure that the LES model is working appropriately, it is useful to 

examine the general characteristics of the flow.  Eddies ranging in size from the pipe 

diameter to the grid spacing should be resolved if the model is working correctly.  A 

contour plot of the fluid velocity as seen in cross sections through the fluid domain helps 

to visualize the flow and confirms the presence of the expected eddies.  Such a plot is 

shown in Figure 3-2 for the initial and final time steps (0.0 s and 0.25 s) of the 4 m/s 

solution.  Both end views and side views are shown at each time step.  The large eddies 

are clearly visible as indicated by the spatial variation in the fluid velocity.   

3.4 Model Verification 

In CFD simulations, or any numerical model, there are differences between the 

exact analytical solution of the modeled differential equations and the fully converged  
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Figure 3-2 Contours of fluid velocity at first and last time step of 4 m/s solution 

 

solution of their discrete representations.  These differences are referred to as 

discretization errors.  These errors in the values of the principle variables being solved for 

are both generated by localized sources and propagated throughout the solution domain.  

Localized sources of error result from the higher-order terms that are excluded from the 

modeled equations when they are discretized.  Error propagation results from the form of 
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the terms that are included in the discrete approximations. Both error sources and 

propagation are affected by the solution and mesh distributions.  The model can only be 

successful if it arrives at a solution that is suitably close to the true solution to the original 

equations.  Because the discretization errors are related to the mesh size, time step size,  

and solution procedure, the accuracy of the solution can be estimated by analyzing how 

the numerical solution changes in response to changes in grid density, time step, and 

convergence criteria.  This process is called verification, and it allows one to express 

confidence that the numerical model gives a correct solution to the governing system of 

equations. 

3.4.1 Grid Size 

The previously described mesh that was used for all of the simulations contains 

approximately 1.9x106 nodes.  Two additional meshes were produced with the same 

general O-grid structure, but containing fewer nodes, and therefore larger mesh spacing 

in all dimensions.  The other meshes contain approximately 6x104 and 4x105 nodes 

respectively.  An image comparing the three meshes is shown in Figure 3-3. 

 

 

Figure 3-3 Meshes used for verification 
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The three meshes were each used for a complete simulation including the 

initialization procedure mentioned above.  The course mesh (6x104 nodes) was used to 

initialize all of the comparative simulations for 5000 time steps.  The medium mesh 

(4x105 nodes) and final mesh (1.9x106 nodes) were each run for 2000 additional time 

steps to achieve statistically steady flow variables.  Finally, all meshes were used in 

simulations lasting 1000 time steps during which mean flow parameters were calculated.  

These mean flow variables are compared for verification purposes.   

The first comparison is of the time-averaged velocity profiles from the 0.8 m/s 

solution as shown in Figure 3-5.  The velocity profiles all appear very similar, especially 

those found on the medium and fine meshes.  However, there are some slight differences.  

Both the medium and coarse meshes tend to modestly under-predict the velocity gradient 

near the wall.  This is to be expected since the wall region is not as well refined.  As a 

result of the inadequate wall resolution, the solver applies wall treatment using an 

assumed log-law profile.  This causes changes in the rest of the velocity profile as well.  

The coarse mesh compensates with a steeper log region and has a similar core, or wake, 

as the fine mesh.  The medium mesh keeps the same wall treatment as the fine mesh 

resulting in a similar log region, but over-predicts velocity in the wake.  Overall, the 

velocity profile does not seem to be particularly sensitive to mesh refinement at these 

levels. The maximum velocity difference between the coarse mesh and fine mesh is about 

4%, and the maximum difference between the medium mesh and fine mesh is 2%. 

Another flow parameter that can be compared for the three meshes is the average 

wall shear stress.  This value is averaged in time, and over the entire wall surface.  Table 

3-4 shows the difference in wall shear stress for the different grids.  The wall shear stress  
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Figure 3-4 Grid resolution comparison: Time-average velocity profile from 0.8 
m/s solution 

 

difference between the medium mesh and fine mesh are nearly negligible due to the 

operation of the wall function.  Although it may appear the coarse grid is sufficient, the 

fine grid is used to keep the lower near wall 𝑟𝑟+value at the highest Reynolds number.  

 

Table 3-4 Wall shear stress for different meshes 

Number of Grid Nodes Wall Shear Stress % Difference  

60,000 1.66 Pa +3.75% 

400,000 1.59 Pa -0.63% 

1,900,000 1.60 Pa - 
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Because the pressure fluctuations at the wall are the driving force for pipe vibration, 

it is useful to consider how sensitive the amplitude of the pressure fluctuations is to the 

grid size.  The averaged standard deviation of the wall pressure fluctuations, 𝑃𝑃′ , is shown 

in Table 3-5 for the three meshes. 

 

Table 3-5 Pressure fluctuation amplitude for different meshes 

Number of Grid Nodes 𝑃𝑃′  % Difference  

60,000 4.49 Pa -0.44% 

400,000 4.54 Pa +0.67% 

1,900,000 4.51 Pa - 

 

3.4.2 Time Step 

The numerical solution accuracy depends not only on the grid resolution, but the 

time step resolution as well.  The size of the time step is important for convergence of the 

iterative solution techniques, and in transient simulations it is important to the values of 

the principle variables.  LES in particular suffers from too much diffusion if the time step 

is too large, or if lower order transient discretization schemes are used.  The effect of the 

time step is determined by comparing velocity profiles as was done when comparing grid 

resolution effects.  In this case, three different time step sizes were evaluated: 0.005 s, 

0.0015 s, and .0005 s.  These time steps correspond to Courant numbers of 1.87, 0.56, 

and 0.19 respectively.  There is no noticeable difference in the velocity profile for any of 

these time steps, as illustrated in Figure 3-5.  Time steps resulting in Courant numbers 

any higher than about 1.8 sometimes force the solver to exit because of difficulty 
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converging.  Solutions using a time step with Courant number any smaller than 0.1 take a 

very long time to reach statistically steady flow.  For the simulations used in this 

research, the use of any stable time step does not affect the quality of the solution, but 

does affect how long it takes to arrive at a solution. 

 

 

Figure 3-5 Time step size comparison: Time-average velocity profile from 0.8 m/s 
solution 

   

3.4.3 Convergence Criteria 

The final aspect of the solution settings that needs to be verified is the iteration 

convergence criteria.  Generally forcing the iterations to continue until a smaller residual 
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value is reached before continuing to the next time step will result in solutions that are 

closer to the actual solution.  Moving to the next time step before the solution is 

converged can lead to significant error propagation and erroneous results.  The 

convergence target, set before the solution is started, controls when iterations will stop 

and move to the next time step.  The effect of changing this target value was considered 

as part of the verification study.  Convergence targets of 1x10-4, 1x10-5, and 1x10-6 were 

each used.  Most time steps using the 1x10-4 convergence criteria required four iterations.  

Requiring the residuals to reach a value below 1x10-5 resulted in an average of five 

iterations per time step.  The strictest criteria of 1x10-6 required an average of six 

iterations per time step.  A comparison of velocity profiles after several hundred time 

steps indicates no difference within single machine precision.  Sometimes using only 

three or four iterations per time step resulted in a solver error causing the program to exit.  

Because more than five iterations did nothing to change the solution, the criterion of 

1x10-5 for the residuals was used in all of the simulations. 

3.5 Validation 

In addition to verifying that the numerical method has produced an accurate 

solution to the governing equations, it is useful to know if the equations including 

boundary conditions are an appropriate representation of the physical system being 

modeled.  Because there are so many settings and techniques that can be applied so easily 

in a CFD simulation, the solution needs to be validated by comparison to measured 

results.  The LES model used here has been validated using two comparisons to empirical 
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(3-23) 

(3-24) 

(3-25) 

(3-22) 

data.  Turbulent pipe flow has received considerable experimental attention and there is 

significant data available for comparison.   

The logarithmic law of the wall proposed by Von Karmen [25] has been shown to 

fit experimental data for high Reynolds number turbulent flows.  The law of the wall is 

expressed as a relationship between the dimensionless fluid velocity and the  

dimensionless wall distance.  For a cylindrical pipe it is: 

𝑢𝑢+ =
1
𝜅𝜅

ln 𝑟𝑟+ + 𝐶𝐶+ 

where  𝐶𝐶+ is a constant determined experimentally to be 𝐶𝐶+≈ 5.0, and 𝑢𝑢+ is the local 

time-averaged fluid velocity non-dimensionalized by the friction velocity 

𝑢𝑢+ =  
𝑢𝑢
𝑢𝑢𝜏𝜏

. 

The law of the wall fits experimental turbulent pipe flow velocity profiles in the region 

above the viscous sub-layer, but does not fit the region in the center of the pipe as 𝑟𝑟 → 0.  

A better correlation that is valid for smooth pipes, including the core region, was 

proposed by Guo and Julien [26] and shown to fit experimental pipe data very well  

everywhere except near the wall.  The modified log-wake law is: 

𝑢𝑢+ =
1
𝜅𝜅

ln 𝑟𝑟+ + 𝐶𝐶+ + 2 sin2 𝜋𝜋𝜋𝜋
2
−

1
𝜅𝜅
𝜉𝜉3

3
 

where  𝜉𝜉 is the wall distance compared to the pipe radius, or: 

𝜉𝜉 =
𝑅𝑅 − 𝑟𝑟
𝑅𝑅

. 

If the CFD model of pipe flow is valid, it should match the experimental data, and 

therefore be fit closely by the log-wake law.  For the LES model, the worst case 

simulation (where the most modeling of the small scale turbulence is done) is at the 
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highest Reynolds number where the 𝑟𝑟+value of the near wall node is highest.  This 

simulation has the poorest grid resolution because of the higher Reynolds number and 

smaller turbulence scales.  The velocity profile for this case with Reynolds number 𝑅𝑅𝑅𝑅𝐷𝐷= 

1.14x106 is compared with the log-wake law which has been shown to yield excellent 

agreement with experimental data.  Figure 3-6 shows this comparison.  The poorer fit to 

the log-wake law below 𝑟𝑟+≈ 1000 near the wall is due to the failure of the grid to fully 

resolve the near wall region.  The LES model relies on the solver wall function which 

influences the velocity profile here.  The rest of the velocity profile fits the log-wake law 

very well, indicating that the LES model is representing physical pipe flow appropriately. 

 The LES model was also validated by comparing the Darcy friction factor of the 

model with the measured friction factor for a smooth pipe.  Experimental data has been 

obtained for a wide range of Reynolds numbers and presented on the classical Moody 

Diagram.  The lower bound for friction factor occurs when a pipe is perfectly smooth.   

 

 

Figure 3-6 High Reynolds number velocity profile 
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Because the model does not consider surface roughness effects, it will be compared 

to the line on the Moody diagram for perfectly smooth pipes.  The friction factor in the 

LES simulations is determined from the wall shear stress.  Tabulated values for 

experimental friction factor are reported in comparison to those from the model in Table 

3-6.  With a maximum relative error of less than 10% the numerical results are within the 

uncertainty range of the experimental data, again indicating an appropriate model of the 

physical system. 

 

Table 3-6 Friction factor comparison with experimental data 

Reynolds Number LES model Moody Diagram Relative Error 

91,000 0.0201 0.0185 8.4% 

114,000 0.0189 0.0179 5.8% 

227,000 0.0163 0.0155 5.0% 

341,000 0.0149 0.0143 4.1% 

455,000 0.0138 0.0135 2.2% 

569,000 0.0132 0.0130 1.2% 

796,000 0.0123 0.0123 0.1% 

1,140,000 0.0115 0.0115 -0.2% 
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4 FEA Structural Model 

The structural model of the pipe was created using ANSYS Multiphysics.  This 

model experiences transient deformation in response to pressure fluctuations calculated 

by the fluid model.  It uses the finite element method (FEM) which is also referred to as 

FEA, or finite element analysis, when applied to an engineering problem.  This is a 

numerical approach which breaks the structural domain up into discrete elements and 

builds a system of algebraic equations relating the stress and strain of each element to 

that of its neighbors.  Each element is required to be in balance such that the sum of all 

forces acting on the element is equal to the mass of the element times its acceleration.  A 

simplistic construction of this relation is: 

𝑀𝑀𝑀𝑀 = 𝐹𝐹 − 𝐵𝐵𝐵𝐵 − 𝐾𝐾𝐾𝐾 

where 𝑀𝑀 is the element mass, 𝐴𝐴 is the element acceleration, 𝐹𝐹 is an external applied 

force, 𝐵𝐵 is the damping coefficient, 𝑉𝑉 is the element velocity, 𝐾𝐾 is the element stiffness, 

and 𝛿𝛿 is the element displacement.  A system of equations consisting of this relation 

repeated for each element in each degree of freedom must be solved, since the stiffness 

and displacement depend on the relative location of each element’s neighbors.  The 

solution to this system of equations returns the principle variables 𝐴𝐴, 𝑉𝑉, and 𝛿𝛿 for each 

discrete location. 

(4-1) 
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4.1 Model Physics 

Similar to the fluid model, the structural model is solved in a defined region or 

domain, which is discretized into elements.  Portions of the domain are defined as 

boundaries where the solution is restricted, or forced to match prescribed conditions.  The 

physical properties of the material represented in the domain are specified and external 

loads are applied.  Finally, the solver approach is chosen and the solution is calculated. 

4.1.1 Domain and Elements 

The pipe is represented in the FEA model by a two-dimensional surface.  This can 

be thought of as a flat sheet that has been rolled up and spliced together forming a tube.  

The FEA domain is a cylindrical surface that corresponds to the average radial location of 

the pipe wall.  The diameter of the FEA domain is related to the internal pipe diameter, 

and is simply 𝐷𝐷 + 𝑡𝑡, where 𝐷𝐷 is the internal diameter and 𝑡𝑡 is the wall thickness.  Two 

different classes of simulations were run that used two different domains with the 

difference between the two being the length of the cylindrical surface.  The short pipe 

model is the same length as the fluid domain, being 0.3 m long, while the long pipe 

domain is 2.4m long.  The discretized domain has 59 circumferential segments and 45 

axial segments for the short pipe.  The long pipe model has 359 axial segments.  This 

discretization results in rectangular elements that are about 5 mm wide and 6.7 mm long.  

A Cartesian coordinate system is used with the positive x direction aligned with the axis 

of the cylinder and the inlet being in the yz plane. 

Because the FEA representation of the pipe is a two-dimensional cylindrical 

surface, a 2-dimensional ANSYS element is specified.  The element type is a shell63 
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element that has four nodes, one at each corner.  Figure 4-1 shows a representation of the 

element with the node numbers, geometry, and local coordinate system defined.  Shell63 

elements have both bending and membrane capabilities and permit both in-plane and 

normal loads. The element has six degrees of freedom at each node: translations in the 

nodal x, y, and z directions and rotations about the nodal x, y, and z-axes.  This element 

can have a different thickness specified at each node, but uniform thickness was used for 

the simulations described here.   

 

 

Figure 4-1 Diagram of a shell63 element 

 

The use of shell elements reduces the computation time significantly compared to 

using full solid elements and a three-dimensional domain.  The use of shell elements is 

generally considered appropriate for thin structures.  In this case the pipe is being 

modeled as a thin-walled cylinder.  As long as the pipe thickness is below about 0.1 

diameters, the thin wall assumption does not significantly alter the values of quantities 
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important to the solution, such as maximum hoop stress (difference of 1% for 𝑡𝑡 𝐷𝐷⁄  = 0.1) 

or the area moment of inertia (also different by only 1% for 𝑡𝑡 𝐷𝐷⁄  = 0.1). 

A Matlab® code was written to aid in the generation of the structural mesh.  This 

custom program was used to ensure control over the node numbering and locations, and 

to generate a file that could be used by the ANSYS program to import the node locations 

and generate the elements.  A copy of the code used to create the input file is included in 

Appendix E. 

4.1.2 Boundary Conditions 

Boundary conditions were applied differently to the long and short pipe models.  

The goal of the short pipe model was to represent a very stiff pipe.  This model used 

fixed-fixed conditions where both ends of the pipe were restricted from moving in all 

dimensions.  Practically, this was done by limiting the degrees of freedom for all of the 

nodes on either end of the pipe.  The long pipe model used simply supported end 

conditions which are intended to limit the deflection of the pipe ends, but not restrict the 

rotation.  This model was used to represent the majority of industrial pipe systems where 

the pipe is supported at various locations along its length.  The simply supported 

condition was applied by first limiting all degrees of freedom for a single node on the 

inlet end of the pipe.  The degrees of freedom corresponding to the circumferential and 

radial directions (z and y respectively) were limited for the corresponding node on the 

outlet end of the pipe.  A second node on the inlet side of the pipe was also restricted in 

the circumferential direction to keep the entire pipe from rotating about the line between 

to two other restricted nodes.  In total, three nodes were given displacement restrictions 

for the long pipe model.  Figure 4-2 shows an image of the short pipe model as 
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discretized, with red arrows indicating restricted degrees of freedom at the applicable 

nodes.  The model orientation with respect to the coordinate system is also indicated by 

the triad in the center of the pipe inlet.  Figure 4-3 shows a similar image of the long pipe 

model illustrating the simply supported boundary conditions.  Again, the red arrows 

indicate restricted degrees of freedom at the nodes towards which they point.   

 

 

Figure 4-2 Short pipe with boundary conditions applied 
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Figure 4-3 Long pipe with boundary conditions applied 

 

4.1.3 Solver Settings 

The ANSYS structural solver was run in batch mode to make the procedure more 

easily repeatable since it was run nearly 100 times to cover the range of interest for all of 

the variables listed in Table 1-1.  A batch file was created for each run to initialize and 

specify all of the needed parameters including geometric and material properties.  The 

batch file also specified the other required solver settings and input the external loads at 

each time step.  A printout of a sample batch file is included in Appendix F. 

The material properties and certain element specific constants are required before 

the elements are created.  The only constant required for the shell63 element is the 

thickness.  The values for the material properties and element thickness were varied from 
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(4-3) 

(4-4) 

(4-2) 

one simulation to the next by adjusting the parameters in the batch file.  The only 

material properties specified for the short pipe simulations were elastic modulus and 

Poisson ratio.  The long pipe simulations required the additional material properties of 

density and structural damping coefficient.  The structural damping coefficient is used 

only in transient analysis.  It is set as a constant dependant on the material composing the 

domain and has units of seconds.  The structural damping coefficient is defined as: 

𝛽𝛽 =
𝜁𝜁
𝜔𝜔𝑛𝑛

 

where 𝜁𝜁 is the unitless damping ratio, and 𝜔𝜔𝑛𝑛  is the natural frequency of the pipe.  This 

parameter controls the damping term in the system of equations, effectively providing 

more damping for the higher frequency modes of vibration.  The material density is set to 

represent the equivalent density required to account for the combined mass of the pipe 

and the fluid.  Because the cross section of the pipe is constant along its length, this 

parameter is constant for a given pipe material, pipe thickness, and internal fluid.  The 

mass of the fluid per unit length contained in the pipe is: 

𝑀𝑀𝑓𝑓 = 𝜌𝜌𝑓𝑓𝜋𝜋𝑅𝑅2 

where 𝜌𝜌𝑓𝑓  is the density of the fluid, and 𝑅𝑅 is the inner pipe radius.  The mass of the pipe 

is calculated in a similar fashion.  Using the thin wall assumption, the pipe mass is: 

𝑀𝑀𝑝𝑝 = 𝜌𝜌𝑝𝑝2𝜋𝜋 �𝑅𝑅 +
𝑡𝑡
2�
𝑡𝑡 

where 𝜌𝜌𝑝𝑝  is the density of the pipe material and t is the pipe thickness.  The equivalent 

density, which is assigned as a material property in the simulations, is then calculated by 

dividing the total mass by the cross sectional area of the pipe wall as follows: 
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(4-5) 𝜌𝜌𝑒𝑒𝑒𝑒 =
𝑀𝑀𝑓𝑓 + 𝑀𝑀𝑝𝑝

2𝜋𝜋 �𝑅𝑅 + 𝑡𝑡
2� 𝑡𝑡

. 

Using the equivalent density defined this way allows the mass per unit length of the 

empty FEA pipe to match the mass per unit length of an equivalent pipe full of fluid.  For 

analytical models that consider the pipe as a beam, the mass per unit length is the 

specified parameter.  Because the bending modes are expected to dominate the response 

of the long pipe model, the density was defined using this approach. 

Some solver settings remained consistent for all of the simulations.  Each 

simulation was set to use 1000 total time steps.  The time step size was set to match that 

used by the fluid solution from which the externally applied loads originated.  To keep 

the results file size manageable, the output variables were restricted to the nodal 

displacement, velocity and acceleration.  Other solution variables such as stresses were 

used during calculations, but disposed of after the completion of the time step.  Each of 

the simulations specified the use of the same method for solving the algebraic system of 

equations.  Iterative methods generally have reduced memory requirements and work 

well for very large meshes.  Direct methods such as the ANSYS sparse solver generally 

require more computer memory, but use only a single iteration for each time step.  This 

makes these methods very fast if the computer has the available resources to allow their 

use.  The short mesh used in these simulations consists of about 3000 elements and the 

long mesh has about 20,000 elements.  These models have sufficiently few elements to be 

solved using the sparse solver, which uses Gaussian elimination to find the single 

solution to the system of equations. 

The transient method was set differently for the long and short pipes.  All of the 

short pipe simulations had time integration turned off, resulting in faster solution times, 
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but neglecting transient effects associated with the inertia of the pipe. This was justified 

after discovering that inertial effects for the short, stiff pipe did not affect the solution 

(having the time integration setting on or off did not produce differing results).  The long 

pipe simulations were all performed using full transient analysis by having the time 

integration setting turned on. 

 

4.2 Model Verification 

Like the LES fluid model, any FEA structural model requires verification studies to 

ensure the numerical method is arriving at a solution that represents a real solution to the 

mathematical model it approximates.  This is done by determining what effects the 

element type, grid resolution, and time step size have on the solution.  Each should then 

be chosen such that further refinement gives no change in the solution. 

4.2.1 Element Type 

The shell elements for these simulations use a thin-walled pipe assumption.  The 

effects of this assumption are most noticeable for the short pipe which responds to the 

spatially varying pressure field differently than the long pipe.  Bending deformations like 

those in a beam tend to dominate the long pipe motion, making local deformation less 

noticeable.  The local deformations of the short pipe, which are more sensitive to the thin 

wall assumption, tend to dominate their response.  An additional short pipe model using 

solid elements was constructed for comparison to the shell model.  The solid model had 

three elements through the thickness of the pipe wall, with the same size elements as the 

shell model in the circumferential and axial directions.  It was constructed such that the 
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average radius matched that of the shell model.  The standard deviation of the pipe wall 

displacement of the solid and shell models was compared at several pipe wall thickness 

settings.  As expected, the thicker pipe wall models differed more between shell and solid 

meshes than thin-walled models.  A plot of the relative difference in the standard 

deviation of the pipe wall displacement between the shell and full solid models is shown 

in Figure 4-4.  The maximum difference occurs for the 8mm thick pipe wall, and it is less 

than 3%.  The full solid model makes fewer assumptions than the shell model and uses 

higher order elements so it is expected to be more accurate, but did not produce 

significantly different results.  The difference between methods is not large enough to 

justify the use of the much more computationally expensive solid element model.  

  

 

Figure 4-4 Relative difference in the standard deviation of the wall displacement 
between shell vs. solid element modeling as a function of wall thickness 
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4.2.2 Grid Size 

Grid independence was established by using three different grids with successive 

node spacing reduction by a factor of two.  For the short pipe this results in a coarse grid 

with about 2800 nodes, a medium grid with about 11,000 nodes, and a fine grid with 

about 44,000 nodes.  The three grids were all employed on models with pipe wall 

thickness of 1 mm, 3 mm, and 6 mm.  As shown in Table 4-1, the maximum difference in 

the standard deviation of the pipe wall displacement between the results obtained by 

using the coarse mesh and those obtained by using the fine mesh is less than 5%.  This is 

considered by the author as acceptable for use in the present simulations which exhibit 

results varying by orders of magnitude over the ranges explored of the influencing 

variables.  The use of the coarse mesh is justified by the relatively small difference in 

results compared to finer meshes, considering that it cuts the solution time by more than 

an order of magnitude compared to the fine mesh computation time. 

 

Table 4-1 Structural mesh refinement effects 

Thickness 

(mm) 

Wall Displacement (𝑆𝑆′) in μm Difference from Fine 
Mesh Results  

Coarse Medium Fine Coarse Medium 

1 0.193 0.189 0.184 4.9% 2.7% 

3 0.0214 0.0209 0.0206 3.9% 1.5% 

6 0.00543 0.00526 0.0052 4.4% 1.2% 
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4.2.3 Time Step 

The time step size for the transient pipe structural analysis was fixed to be the same 

as the time step used for the LES fluid analysis.  Although it would be possible to shorten 

the time step for the structural FEA model, the loading conditions from the fluid solution 

would not be updated each time step.  This would lead to unnatural behavior of the 

solution as the step changes in loading conditions would appear to have some very high 

frequency content.  Although shorter time steps could not be tried effectively, the effect 

of the time step size was analyzed by doubling the time step and considering only every 

other time series data point from the fluid solution.  For the pipe wall displacement there 

is very little noticeable effect (less than 0.2% change) from increasing the time step this 

way.  Removing every other sample by doubling the time step has the same effect as 

applying a low pass filter that cuts out the higher frequency content.  Because the 

pressure fluctuations at each node contain several samples per cycle of the highest 

frequency component, removing samples had very little effect.  The velocity and the 

acceleration of the pipe wall tend to respond most readily to the high frequency content 

however, and these variables did change with increasing time step.  The standard 

deviation of pipe wall velocity dropped by up to 1.7% for the worst case (pipe with 

highest response frequency), and the acceleration dropped by as much as 12% for the 

worst case.  A plot of an acceleration time series for both time step sizes is shown in 

Figure 4-5. The loss of high frequency content for the larger time step can be seen 

clearly.  Because of the differences that result when using a coarser time step, the original 

time step matching that of the fluid solution was used for all of the structural simulation 

to limit any potential loss in accuracy.  
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Figure 4-5 Effect of time step size on pipe wall acceleration 

 

4.3 Validation 

The structural model was validated by comparing results to those obtained using 

analytical and experimental models.  The analytical validation was done by comparing 

the FEA results to the predicted static radial deflection due to a uniform internal pressure, 

and static beam deflection due to a distributed load.  The experimental validation was 

done by comparing the frequency content of the excited transient response of a real pipe 

to the natural frequencies of the FEA model predicted using a modal analysis. 

4.3.1 Static Validation 

The static radial deflection of a pipe subjected to uniform internal pressure can be 

determined by using an analytical expression for the hoop stress and the material elastic 

-0.008

-0.006

-0.004

-0.002

0

0.002

0.004

0.006

0.008

0 0.05 0.1 0.15 0.2 0.25

A
cc

el
er

at
io

n 
(m

/s
2 )

Time (s)
∆t = 0.0005 s ∆t = 0.001 s



54 

modulus.  Using the thin wall assumption, the hoop stress in the wall of a long cylinder 

is: 

𝜎𝜎𝜃𝜃 =
𝑃𝑃𝑃𝑃
𝑡𝑡

 

where 𝑃𝑃 is the internal pressure, 𝑅𝑅 is the average pipe radius, and 𝑡𝑡 is the pipe wall 

thickness.  In the linear material behavior region the strain is related to the stress through 

the modulus, so the circumferential strain is: 

𝛿𝛿𝜃𝜃 ≡  
∆𝐶𝐶
𝐶𝐶

=  
2𝜋𝜋∆𝑅𝑅
2𝜋𝜋𝜋𝜋

=
𝜎𝜎𝜃𝜃
𝐸𝐸

 

where C is the circumference of the pipe and E is the elastic modulus of the pipe material. 

Substituting (4-6) into (4-7) and rearranging gives the incremental change in pipe radius: 

∆𝑅𝑅 =  
𝑃𝑃𝑅𝑅2

𝐸𝐸𝐸𝐸
. 

Comparing the analytical hoop stress and change in radius with the values determined by 

ANSYS results in a relative difference of about 2%.  The comparison was made for a 

pipe with 𝑅𝑅 = 0.1015m, 𝑡𝑡 = 2mm, 𝑃𝑃 = 1000Pa, and 𝐸𝐸 = 10GPa.  The summary of results 

from this comparison is included on Table 4-2. 

The second validation study compared the bending displacement of the model with 

that calculated using beam theory.  The maximum deflection of a simply supported beam 

is: 

𝛿𝛿𝑚𝑚𝑚𝑚𝑚𝑚 =  
5

384
𝐹𝐹𝐿𝐿3

𝐸𝐸𝐸𝐸
 

where 𝐹𝐹 is the total magnitude of a load distributed along the length of the beam, 𝐿𝐿 is the 

length between fixed supports, 𝐸𝐸 is the material elastic modulus, and 𝐼𝐼 is the area 

(4-6) 

(4-7) 

(4-8) 

(4-9) 
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(4-11) 

moment of inertia of the beam cross section.  For a thin-walled cylindrical beam, the 

moment of inertia is: 

𝐼𝐼 =  
𝜋𝜋
8
𝐷𝐷3𝑡𝑡 

where 𝐷𝐷 is the mean diameter and 𝑡𝑡 is the wall thickness.  Finally, substituting (4-10) into 

(4-9) gives an analytical expression for predicting the pipe displacement due to beam-like 

bending: 

𝛿𝛿𝑚𝑚𝑚𝑚𝑚𝑚 =  
5

48𝜋𝜋
𝐹𝐹𝐿𝐿3

𝐸𝐸𝐷𝐷3𝑡𝑡
. 

This value was compared for a pipe with 𝐿𝐿 = 2.4m, 𝐷𝐷 = 0.1015m, 𝑡𝑡 = 2mm, 𝐸𝐸 = 10GPa, 

and a total distributed load of 𝐹𝐹 = 20lbs.  The relative difference was approximately 4% 

as shown in Table 4-2. 

 

Table 4-2 Structural model static validation summary 

Variable ANSYS Theory Error 

𝜎𝜎𝜃𝜃  24861 Pa 25375 Pa -2.0% 

∆𝑅𝑅 0.1270 μm 0.1288 μm -1.4% 

𝛿𝛿𝑚𝑚𝑚𝑚𝑚𝑚  0.457 mm 0.438 mm 4.3% 

 

 

4.3.2 Dynamic Validation 

The dynamic validation study used an impact hammer test of an experimental 

section of PVC pipe.  The experimental pipe section had an inside diameter of 5.2 cm and 

wall thickness of 3.91 mm.  The pipe was clamped on both ends of a 1 m long test 

(4-10) 
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section.  An accelerometer was placed at the center of the clamped section of pipe, and 

the pipe was struck with an impact hammer near the accelerometer.  The accelerometer 

response was sampled at 5 kHz, and the time signal was converted to the frequency 

domain using a fast Fourier transform (FFT).  The impact hammer procedure was 

repeated five times, and the five resulting spectral distributions were averaged.  This is 

considered a small number of averages [27] and results in a noisy spectrum with poor 

amplitude estimates.  However, the amplitude of the peaks is not of interest for this 

comparison, only their location. 

A modal analysis was done on a structural model in ANSYS having geometry 

matching that of the experimental pipe.  The density was set at 1300 kg/m3 and the elastic 

modulus was set to 2.5 GPa and 3.0 GPa.  Because the modulus of PVC has some 

variability, there is uncertainty in the modulus value used and corresponding uncertainty 

in the natural frequencies found by the modal analysis.  The upper and lower modulus 

values were used to determine a range of natural frequencies that account for the 

uncertainty in the modulus.  The natural frequencies from the modal analysis are plotted 

along with the spectral distribution from the experimental accelerometer measurement in 

Figure 4-6.  The natural frequencies from the modal analysis of the ANSYS model fall 

fairly close to the peaks in the experimental data, indicating the experimental system has 

natural frequencies similar to the numerical model.  Some of the apparent peaks from the 

experimental data may be noise due to the insufficient number of averages.  

Discrepancies could also be caused by differences in the experimental boundary 

conditions which may allow additional modes of vibration that are restricted in the FEA 

model. 
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Figure 4-6 Comparison of ANSYS and experimental natural frequencies (lighter 
bands indicate uncertainty range in ANSYS predictions) 
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5 FSI Coupling Procedure 

The LES fluid model and FEA structural model are linked through two different 

coupling approaches.  The first approach passes the pressure at the pipe wall from the 

fluid solution to the structural model as a set of external loads.  The structure is then 

allowed to respond to the loads that are updated at each time step.  Because the structure 

responds to the fluid solution, but the fluid solution is not influenced by the structural 

motion, this is called a one-way coupling approach.  The second approach includes the 

additional step of passing the structural motion of the pipe wall back to the fluid model 

by deforming the fluid mesh at the wall boundary.  This two-way approach allows both 

the structural and fluid models to respond to each other and is sometimes referred to as a 

fully coupled FSI model.  The application of both approaches is explained in detail in this 

chapter. 

5.1 One-Way Coupling 

The one-way approach is simpler in theory and makes more assumptions than the 

two-way approach.  It assumes that the structural deformations are small enough that they 

do not influence the flow field.  It has been suggested that pipe wall deflections smaller 

than the viscous sub-layer thickness will not influence the turbulence generation of the 

flow [9,11].  Although the one-way model is simpler, application of the technique 
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(5-1) 

actually requires more effort than the two-way approach in order to take advantage of the 

potential computational benefits it offers.  The one-way approach was used for nearly all 

of the simulations because of the significant reduction in computation time.  The fluid 

model takes approximately 40 times longer to solve than the structural model.  Because 

the one-way approach requires the fluid model to be solved only once, it is a much more 

efficient way to explore pipe geometric and material parameters. 

5.1.1 Pressure Extraction 

CFD models using a periodic boundary condition on the inlet and outlet suffer from 

a potential for “floating” pressure in the domain.  A valid pressure field that satisfies the 

governing equations can have any constant added to it and still satisfy the equations 

unless a boundary condition involving pressure is included.  Most CFD models include a 

pressure boundary somewhere to fix this constant.  The LES model with a periodic 

inlet/outlet fixes the pressure at a single node to always be a certain value.  The entire 

pressure field is then determined relative to this reference pressure.  Unfortunately, the 

structural model requires the loads to be defined relative to a fixed external pressure.  

This requires the pressure field from the fluid solution to be transformed in terms of a 

new reference before use in the FEA model.  The transformation is made by adding the 

absolute pressure at the fixed node to the entire pressure field at each time step.  The 

absolute pressure at the fixed node is taken to be the negative of the volume averaged 

pressure so the new pressure field needed by the structural model can be calculated as: 

𝑃𝑃𝑛𝑛𝑛𝑛𝑛𝑛 = 𝑃𝑃 − 𝑃𝑃� 

where  𝑃𝑃 is the pressure value stored in the fluid solution and 𝑃𝑃� is the instantaneous 

pressure averaged over the entire fluid domain.  The calculation of  𝑃𝑃� must be done 
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separately for each time step when making the transformation.  The CFX post processor 

includes a custom function option that allows this new variable to be defined and 

exported for all nodes on the wall.  The transformed pressure data for use in the structural 

model was exported to a series of text files, each containing the pressure data for a 

particular time step.  Because the pressure extraction procedure from CFX needed to be 

repeated 1000 times for each of eight flow solutions, a script was written that would 

automate the procedure.  Doing this through the normal menus in the post processer 

would not have been practical.  A copy of the script is included in Appendix C. 

5.1.2 Pressure Mapping 

The long pipe structural model is eight times as long as the fluid model.  This 

requires the pressure field to be repeated eight times in the axial direction.  There are also 

many fewer surface nodes in the structural model than in the fluid model.  The fluid 

model contains four nodes for every structural node in both the circumferential and axial 

directions.  The fluid model requires the higher grid resolution to get the proper turbulent 

structures to develop and to produce the proper pressure field.  Physically, the pipe wall 

acts to smooth out or average the spatially varying pressure fluctuations.  This is one 

reason why the FEA model can use a coarser mesh and still accurately represent the 

physical system.   

For all of the one-way simulations, the transformed pressure data from each 

solution was imported into Matlab® and stored as a 236x180x1000 array corresponding to 

the 236 circumferential nodes, 180 axial nodes, and 1000 time steps from the fluid 

solution.  The pressure data was then reduced using an area averaging scheme.  

Overlapping 5x5 sections of the array were averaged to produce a single pressure value 
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for that region to be mapped to a structural node.  This resulted in a 59x45x1000 array of 

pressure data corresponding to the coarser structural mesh.  An example of the original 

fluid pressure field and the reduced field for the structural mesh is shown in Figure 5-1 

for comparison.  The reduced pressure field was then repeated axially eight times to 

match the longer structural domain.  The reduced pressure field was finally converted to 

forces by multiplying by the structural element area at each node and decomposed into y 

and z components for easier application in ANSYS.  A file including a series of 

commands to apply all of the nodal forces was created for each time step.  These files 

were then imported for use by ANSYS at each time step during the solution of the 

structural model to apply external loads.  The pressure mapping procedure required the 

use of a Matlab program to import the pressure data, manipulate it to fit the structural 

mesh, and write the ANSYS input files.  A copy of the code is included in Appendix D. 

 

 

Figure 5-1 Pressure field before and after averaging (original field on left) 
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5.2 Two-Way Coupling 

The two-way procedure is considered necessary when the structural deformation 

will affect the flow field.  Even if the maximum pipe wall displacement is smaller than 

the viscous sub-layer, the pipe wall motion causes a non-zero radial velocity at the wall.  

The no-slip condition forces this velocity to be matched by the fluid adjacent to the wall.  

Also, because the LES model calculates the instantaneous velocity and pressure values (it 

is a time accurate transient technique), even small changes in the wall boundary location 

may have an effect on the flow field.  For these reasons, the two-way solution may not 

produce the same results as the one-way procedure even with very small pipe wall 

displacement.  The two-way procedure was used as a way to validate the one-way FSI 

model by determining the magnitude of the difference in results.  If using the two-way 

procedure does not produce different results, it is not practical because of the 

significantly higher computation cost over the one-way model.   

5.2.1 Application 

The two-way technique does not require the pressure extraction and mapping 

procedures because ANSYS has a built-in function that takes care of interpolating 

between dissimilar meshes between time steps.  The built in interpolator is slow 

compared to the Matlab program used in the one-way procedure, but because it can be 

done without exiting the fluid solver it makes the two-way procedure a practical 

possibility.  The fluid solver requires a few additional settings to let it know which 

boundaries will deform in response to the structural solution.  It also needs to be told to 

pass the pressure data each time step through the interpolator to the structural solver.  The 
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structural model also requires additional settings so it can pass the wall displacement 

through the interpolator to the fluid mesh.  It must be set to accept external loads each 

time step from the fluid solver rather than from existing files. 

The two-way model was used for only 600 time steps because the results files it 

generated became too large to open for post processing and extracting pipe wall motion 

data.  It required about two weeks of continuously running on four processors, which is 

almost six times as long as a normal fluid solution alone.  The additional time was a 

result of the iterative process required to have the boundary values of both the fluid 

solver and structural solver agree.  The multiple iterations cause the fluid model to be 

solved about five times for each time step.  The results file for 600 time steps was over 

140 Gigabytes.   

5.2.2 Comparison With One-Way Approach 

The two types of coupling procedures were compared by first allowing the flow 

field to become statistically steady with no coupling settings.  This flow field was then 

used as the initial condition for a flow solution to be used in a one-way approach, and for 

the initial state of the fully coupled two-way flow solution.  The two-way procedure was 

run to completion as described.  The one-way procedure was then applied to extract and 

map the pressure data from the uncoupled flow solution.  The simulations were both done 

using the short pipe mesh so transient structural effects were not considered in the one-

way model.  The average fluid velocity was set to 2 m/s and the fluid properties were 

those of water as specified in chapter 3.  The elastic modulus of the pipe was set to 3.7 

GPa and the wall thickness was set to 6 mm.  The pipe material density for the two-way 

model was set to 1300 kg/m3. 
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The pipe wall motion was first compared by plotting the time series displacement 

calculated by both solutions.  Figure 5-2 shows this comparison.  The solutions appear 

very similar, but the instantaneous wall displacement is not expected to match.  Because 

of the chaotic nature of turbulence, even very small changes in the boundary conditions 

or locations can lead to large changes in instantaneous values in the flow field, especially 

after a long time.  This would be expected to in turn cause changes in the instantaneous 

values of the structural solution which are illustrated in Figure 5-2.  A more important 

measure of the difference between the two methods is to compare statistical values by 

looking at 𝛿𝛿′, 𝑉𝑉′, and 𝐴𝐴′.  The values for these dependant variables were determined by 

averaging over four locations on the pipe wall (top, bottom, left, and right) halfway 

between the clamped ends.  The values are shown in Table 5-1.   

 

 

Figure 5-2 Coupling technique comparison: Time series displacement 
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Table 5-1 Coupling technique comparison summary 

Coupling Technique 𝛿𝛿′(nm) 𝑉𝑉′(μm/s) 𝐴𝐴′(m/s2) 

One-Way 9.77 2.89 0.00349 

Two-Way 10.3 2.9 0.00340 

% Difference 5.1% 0.3% 2.6% 

 

The maximum relative difference between the two techniques occurs for the 

standard deviation of wall displacement at just over 5%.  Because the difference here 

between the two techniques is small negligible relative to the expected differences from 

investigated parameter variation, the use of the much faster one-way model is justified. 
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6 Results 

The results presented in this chapter were obtained by using the models and 

following the procedures described in chapters 3 through 5.  This results chapter first 

describes the general behavior of both the long and short pipe models.  The 

dimensionless variables used to characterize and quantify the pipe behavior are then 

introduced.  The specific effects of each of the dimensionless variables are presented.  

This chapter also presents the complete functional relationships between the independent 

and dependant variables for both the long and short pipe which is the most important 

result of this work.  Finally, the numerical model results obtained here are compared to 

available experimental data from other researchers. 

6.1 General Behavior 

Because the external forces applied to the structural model come from the wall 

pressures determined using the fluid model, it is useful to see how the wall pressure 

fluctuations are affected by the fluid solver parameters.  Figure 6-1 displays the 

relationship between the fluid velocity (which was changed to produce the various flow 

solutions) and the standard deviation of wall pressure fluctuations, 𝑃𝑃′, averaged over the 

entire pipe wall.  Also shown on this plot is the average wall shear stress, 𝜏𝜏𝑤𝑤 .  The 

pressure fluctuations can be fit with a power law curve with 𝑅𝑅2 = 0.9997 indicating that 
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they increase with 𝑈𝑈1.73.  This scales very similarly with the average wall shear stress 

which increases with 𝑈𝑈1.78, indicating that the wall shear is likely the driving factor in 

determining the level of the pressure fluctuations.  The values of wall shear stress 

determined in these simulations are those caused by a smooth wall.  Rough pipe walls 

cause a slightly different scaling of wall shear with velocity.  For high Reynolds number 

flows though rough-walled pipes, the flow is said to be wholly turbulent, and the wall 

shear stress becomes proportional to 𝑈𝑈2, where 𝑈𝑈 is the average fluid velocity.  The 

numerical simulation relation of 𝑈𝑈1.78 is for smooth walls where a wholly turbulent 

condition never exists. 

 

 

Figure 6-1 P’  and τw  as functions of average fluid velocity in a pipe having D = 
0.1015 m with water as the working fluid. 
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The frequency content of the wall pressure from the fluid solution gives some 

indication of how energy is transferred from the fluid to the pipe.  Turbulent pressure 

fluctuations have a wide frequency range of energy content.  The spectral density 

(magnitude of pressure fluctuations plotted versus frequency, f, in Hz) of the pressure 

fluctuations from the 10 m/s fluid solution averaged over the entire wall is shown in 

Figure 6-2.  Experimental turbulent power spectra exhibit a classic energy cascade 

indicated by an amplitude decay with 𝑓𝑓−5 3⁄ .  The pressure spectrum from the LES 

simulations follows this classical behavior.  The pressure fluctuations force the pipe wall 

at this entire range of frequencies, so the pipe is expected to respond with similar 

frequency content.  The short pipe and long pipe display fundamentally different 

behaviors, partly because the short pipe analysis does not include dynamic structural 

effects. 

 

 

Figure 6-2 Wall pressure fluctuations as a function of frequency for the 10 m/s 
flow solution 
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6.1.1 Short Pipe 

The short pipe has very high natural frequencies and is stiff enough to respond 

immediately to the changes in pressure from the fluid solution.  Because the pipe wall 

responds so quickly, a full transient analysis of the short pipe was found to yield the same 

results as a static analysis.  The time series wall displacement is taken from four nodes 

(top, bottom, front and back) situated around the domain, halfway between the inlet and 

outlet.  The frequency content of the displacement at these four locations is averaged and 

presented in Figure 6-3.  There is some noise because of the relatively short (1/10 s) 

sample and averaging over only four nodes, but the trend is clear.  The pipe wall 

displacement exhibits nominally the same characteristic frequency content as the wall 

pressure, but with reduced response to high frequencies.  This may be due to the fact that 

the pipe wall averages out the smallest spatial pressure variations that correspond to the 

highest frequency fluctuations.  

Another behavior of the short pipe is its tendency to respond to local pressure 

variations, undergoing shell-type deformations.  Rather than large portions of the pipe 

moving together as in bending, small areas of the surface deflect relative to adjacent areas 

producing an unordered pattern of valleys and peaks.  Figure 6-4 shows an image of the 

short pipe model at settings of 𝑈𝑈 = 10 m/s, 𝐷𝐷 = 0.1015 m, 𝑡𝑡 = 3 mm, 𝐸𝐸 = 3.7 GPa, with 

exaggerated deflection and color contours of the displacement vector magnitude.  This 

localized deflection was observed to dominate the short pipe motion in all of the 

simulations performed with this model. 
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Figure 6-3 Short pipe pressure and wall displacement as a function of frequency 
for U = 10 m/s, D = 0.1015 m, t = 3 mm, E = 3.7 GPa  

 

 

 

Figure 6-4 Short pipe surface deflection pattern for U = 10 m/s, D = 0.1015 m, t = 
3mm, E = 3.7 GPa 
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6.1.2 Long Pipe 

The long pipe model has lower natural frequencies and is not stiff enough to 

respond instantaneously to the changing pressure load.  This inertial effect required the 

use of a full transient analysis.  Due to the inclusion of inertial effects in the long pipe 

model, the pipe responds naturally better to certain frequencies than others.  The effect is 

to amplify the pipe wall motion in certain bands of the broad spectrum over which it is 

excited by the fluctuating pressure.  This effect is illustrated in Figure 6-5 which shows 

the spectral density of the pressure fluctuations overlaid on the spectral density of the 

pipe wall displacement response, with vertical bands indicating natural frequencies 

predicted by a modal analysis.  As seen with the short pipe frequency response, the long 

pipe displacement spectrum has the same characteristic roll-off with increasing 

frequency, including reduced response at the highest frequencies.  However, the long 

pipe also has a clear region of enhanced response which appears to coincide with the 

natural frequencies determined through a modal analysis, although significant noise 

prevents observation of any clearly defined peaks. 

Any local fluctuations along the wall of the long pipe tend to be small relative to the 

pronounced large scale bending motions that dominate its response.  The pipe tends to 

respond to an overall net force imbalance that induces deflections similar to those 

experienced by a beam subjected to a distributed load.  Figure 6-6 shows an image of the 

deformed long pipe at settings of 𝑈𝑈 = 10 m/s, 𝐷𝐷 = 0.1015 m, 𝑡𝑡 = 2 mm, 𝐸𝐸 = 21 GPa, 𝜌𝜌𝑒𝑒𝑒𝑒  

= 3000 kg/m3, 𝛽𝛽 = 0.001with exaggerated displacement scaling and color contours of 

displacement magnitude.  This bending-beam type of deflection is typical of almost any 

time step in all of the long pipe solutions. 
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Figure 6-5 Long pipe pressure and wall displacement as a function of frequency 
content for U = 10 m/s, D = 0.1015 m, t = 2 mm, E = 21 GPa, ρeq = 3000 kg/m3, β = 
0.001.  Also shown are pipe natural frequencies predicted using a modal analysis 

 

 

 

Figure 6-6 Long pipe wall displacement pattern for U = 10 m/s, D = 0.1015 m, t = 
2 mm, E = 21 GPa, ρeq = 3000 kg/m3, β = 0.001 
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(6-1) 

6.2 Non-Dimensionalization 

Dimensional analysis was used to reduce the total number of important variables 

needed to characterize the problem.  The dimensional analysis also gives the results in 

more generalized form, convenient for comparisons with other work.  A complete non-

dimensional set of variables accounts for and represents all of the original dependant and 

independent variables of interest.  The dimensionless forms of each of the dependant 

variables are defined in Table 6-1. 

 

Table 6-1 Dimensionless dependant variables 

Dimensionless 
Variable 

Definition Description 

𝛿𝛿∗ 𝛿𝛿′
𝐷𝐷

 Ratio of standard deviation of pipe wall 
displacement to internal diameter  

𝑉𝑉∗ 𝑉𝑉′
𝑈𝑈

 Ratio of standard deviation of pipe wall velocity to 
average fluid velocity 

𝐴𝐴∗ 𝐴𝐴′𝑡𝑡
𝑈𝑈2  Dimensionless pipe wall acceleration 

 

 

Before defining the dimensionless form of the independent variables it is useful to 

introduce two new variables.  The first represents a characteristic frequency of the fluid 

flow and is defined as: 

𝜔𝜔𝑐𝑐 =
𝑈𝑈
𝐷𝐷

 

which indicates the lowest frequency of coherent structures expected to be present in the 

turbulent flow field [28].  The second variable was actually mentioned briefly in chapter 

4.  It is proportional to the fundamental natural frequency of the pipe in bending. It is 
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defined as: 

𝜔𝜔𝑛𝑛 = �
𝐸𝐸
𝜌𝜌𝑒𝑒𝑒𝑒

𝐷𝐷
𝐿𝐿2 

and is related to the lowest expected natural frequency of a long pipe structure [29].  

Using these two characteristic frequencies the dimensionless independent variables are 

defined in Table 6-2.  The total number of independent variables influencing the pipe 

motion has been reduced from the original 9 (𝜇𝜇, 𝜌𝜌𝑓𝑓 , 𝑈𝑈, 𝐷𝐷, 𝑡𝑡, 𝐿𝐿, 𝜌𝜌𝑒𝑒𝑒𝑒 , 𝐸𝐸, and 𝛽𝛽), to the six 

dimensionless independent variables. 

 

Table 6-2 Dimensionless independent variables 

Dimensionless 
Variable 

Definition Description 

𝑅𝑅𝑅𝑅𝐷𝐷  
𝜌𝜌𝑓𝑓𝑈𝑈𝑈𝑈
𝜇𝜇

 Ratio of fluid inertial forces to viscous forces  

𝑡𝑡∗ 
𝑡𝑡
𝐷𝐷

 Ratio of pipe wall thickness to diameter 

𝐿𝐿∗ 
𝐿𝐿
𝐷𝐷

 Ratio of pipe length to diameter 

𝜌𝜌∗ 
𝜌𝜌𝑒𝑒𝑒𝑒
𝜌𝜌𝑓𝑓

 Ratio of total mass to fluid mass 

𝜔𝜔∗ 
𝜔𝜔𝑛𝑛
𝜔𝜔𝑐𝑐

 Ratio of pipe frequencies to fluid frequencies 

𝜁𝜁 𝛽𝛽𝜔𝜔𝑛𝑛  Damping ratio 
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6.3 Specific Variable Effects 

The first order effects of each of the independent variables are presented for both 

the long and short pipe models.  Each of the dimensionless dependent variables was 

found to have a power-law dependency on each of the dimensionless independant 

variables.  The power law dependencies only apply over the range of variables 

considered. 

6.3.1 Short Pipe 

Because the structural short pipe model was solved without transient effects, and 

because it had few material properties defined, it is affected by only some of the 

independent variables.  Only those variables exerting influence on the short pipe are 

presented here.  Each of the plots include three sets of results indicating the effects of a 

particular independent variable on the three dependant variables, 𝛿𝛿∗,𝑉𝑉∗, and 𝐴𝐴∗.  Because 

the short pipe model does not account for transient structural effects it does not make 

sense to define a natural pipe frequency, 𝜔𝜔𝑛𝑛 .  For this reason, instead of considering a 

ratio of structural and fluid frequencies, a non-dimensional stiffness variable is used in 

the place of  𝜔𝜔∗.  This variable is defined as: 

𝐸𝐸∗ =
𝐸𝐸
𝜌𝜌𝑈𝑈2 

and is the ratio of the elastic modulus of the pipe material to twice the dynamic pressure 

of the fluid.  The short pipe response is then a function of three variables, namely 𝑅𝑅𝑅𝑅𝐷𝐷 , 

𝑡𝑡∗, and 𝐸𝐸∗. 

The short pipe response as a function of the Reynolds number was found by holding 

𝐸𝐸∗ and 𝑡𝑡∗ constant at values of 3.71x106 and 0.0296 respectively while repeating the 



77 

simulation at each of the eight Reynolds numbers.  There is a definite trend in the data 

showing that all of the dependant variables are inversely related to the Reynolds number.  

A plot of the dependence of 𝛿𝛿∗,𝑉𝑉∗, and 𝐴𝐴∗ on 𝑅𝑅𝑅𝑅𝐷𝐷  is shown in Figure 6-7 along with a 

power law curve fit to each data set.  The relationship here is somewhat noisy, likely due 

to the small number of time steps of the fluid simulations.  𝛿𝛿∗ was found to be 

proportional to 𝑅𝑅𝑅𝑅𝐷𝐷−0.26, 𝑉𝑉∗ was found to be proportional to 𝑅𝑅𝑅𝑅𝐷𝐷−0.30, and 𝐴𝐴∗ was found 

to be proportional to 𝑅𝑅𝑅𝑅𝐷𝐷−0.38.  The power law curves fit to the data have average relative 

error values of 10.8% for 𝛿𝛿∗, 6.3% for 𝑉𝑉∗, and 11.1% for 𝐴𝐴∗. 

 

 

Figure 6-7 δ*, V*, and A* as functions of Reynolds number for the short pipe 
model with t* = 0.0296 and E* = 3.71x106 
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Figure 6-8 illustrates the effect of changing the thickness to diameter ratio for the 

short pipe model.  This relationship was determined by holding the other non-

dimensional variables constant at 𝑅𝑅𝑅𝑅𝐷𝐷  = 1.14x105 and 𝐸𝐸∗ = 3.71x106 while varying the 

thickness to diameter ratio.  This plot indicates a strong inverse dependence for all of the 

response variables, with the data all being fit very well by power law curves.  There is 

very little noise here because all of the simulations used the same fluid solution.  𝛿𝛿∗ was 

found to be proportional to 𝑡𝑡∗−2.05, 𝑉𝑉∗ was found to be proportional to 𝑡𝑡∗−1.96, and 𝐴𝐴∗ 

was found to be proportional to 𝑡𝑡∗−0.90.  The average relative error values of the fit 

curves are 3.8% for 𝛿𝛿∗, 1.9% for 𝑉𝑉∗, and 1.4% for 𝐴𝐴∗. 

 

 

Figure 6-8 δ*, V*, and A* as functions of t* for the short pipe model with ReD = 
1.14x105 and E* = 3.71x106 
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Figure 6-9 indicates that all of the dependant variables are inversely proportional to 

𝐸𝐸∗.  The simulations providing these results were all carried out using the same fluid 

solution at 𝑅𝑅𝑅𝑅𝐷𝐷  = 4.55x105, and constant thickness ratio of 𝑡𝑡∗ = 0.0296.  The inverse 

proportionality is expected since the static deflection of any element is inversely 

proportional to the modulus of elasticity.  Neglecting transient effects, the velocity and 

acceleration of the pipe wall are just the first and second derivatives of the wall deflection 

with respect to time, and the inverse proportionality with E still holds for these variables.  

The inverse proportionality curves fit the data remarkably well with negligible relative 

error. 

 

 

Figure 6-9 δ*, V*, and A* as functions of E* for the short pipe model with ReD = 
4.55x105 and t* = 0.0296 
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6.3.2 Long Pipe 

The long pipe model includes the effects of the pipe inertia and is therefore 

influenced by all of the dimensionless independent variables considered.  The first order 

effects of a particular variable were found by allowing that variable to take on different 

values while holding all of the others constant. 

The influence of Reynolds number on the long pipe response is shown in Figure 

6-10.  The other variables were held at 𝑡𝑡∗ = 0.0296, 𝐿𝐿∗ = 23.6, 𝜌𝜌∗ = 3.01, 𝜔𝜔∗ = 0.473, and 

𝜁𝜁 = 0.047.  Like the corresponding data from the short pipe model, the long pipe 

Reynolds number dependence data exhibits some modest variation.  Again, the trend is 

an inverse relationship, although for the long pipe the dependence on Reynolds number is 

weaker than seen for the short pipe model producing nearly flat lines on this plot.  

Because the Reynolds number dependence is so low, the noise is much more visible and 

the values of R2 for the power law curves fit to the data are lower than might be expected.  

The average relative error of the fit curves is 5.2% for 𝛿𝛿∗, 6.2% for 𝑉𝑉∗, and 8.0% for 𝐴𝐴∗.  

The fit curves indicate that 𝛿𝛿∗ is proportional to 𝑅𝑅𝑅𝑅𝐷𝐷−0.20, 𝑉𝑉∗ is proportional to 𝑅𝑅𝑅𝑅𝐷𝐷−0.12, 

and 𝐴𝐴∗ is proportional to 𝑅𝑅𝑅𝑅𝐷𝐷−0.18. 

The thickness ratio dependence simulations for the long pipe were all carried out at 

𝑅𝑅𝑅𝑅𝐷𝐷  = 1.14x106, 𝐿𝐿∗ = 23.6, 𝜌𝜌∗ = 10.0, 𝜔𝜔∗ = 0.473, and 𝜁𝜁 = 0.047.  The data as seen in 

Figure 6-11 indicates that both 𝛿𝛿∗ and 𝑉𝑉∗ are inversely proportional to 𝑡𝑡∗, while 𝐴𝐴∗ 

exhibits little dependence on 𝑡𝑡∗.  Power-law curves fit the data with average relative error 

of 5.4% for 𝛿𝛿∗, 3.4% for 𝑉𝑉∗, and 0.7% for 𝐴𝐴∗.  The curves indicate that 𝛿𝛿∗ is proportional 

to 𝑡𝑡∗−1.16, 𝑉𝑉∗ is proportional to 𝑡𝑡∗−1.06, and 𝐴𝐴∗ is proportional to 𝑡𝑡∗0.04.  The pipe wall 

response variables’ dependence on 𝑡𝑡∗ is lower for the long pipe than for the short pipe.   
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Figure 6-10 δ*, V*, and A* as functions of ReD for the long pipe model with t* = 
0.0197, L* = 23.6, ρ* = 3.01, ω* = 0.473, and ζ = 0.047 
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Figure 6-11 δ*, V*, and A* as functions of t* for the long pipe model with ReD = 
1.14x106, L* = 23.6, ρ* = 10.0, ω* = 0.473, and ζ = 0.047 
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Figure 6-12 δ*, V*, and A* as functions of L* for the long pipe model with ReD = 
1.14x106, t* = 0.0197, ρ* = 3.01, ω* = 0.473, and ζ = 0.047 

 

The density ratio, 𝜌𝜌∗, was varied while holding the other variables at 𝑅𝑅𝑅𝑅𝐷𝐷  = 

1.14x106, 𝑡𝑡∗ = 0.0296, 𝐿𝐿∗ = 23.6, 𝜔𝜔∗ = 0.473, and 𝜁𝜁 = 0.047.  The dependence of the pipe 
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Figure 6-13 δ*, V*, and A* as functions of ρ* for the long pipe model with ReD = 
1.14x106, t* = 0.0296, L* = 23.6, ω* = 0.473, and ζ = 0.047 

 

 

 

Figure 6-14 δ*, V*, and A* as functions of ω* for the long pipe model with ReD = 
1.14x106, t* = 0.0296, L* = 23.6, ρ* = 12.0, and ζ = 0.047 
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The final first order influence of an independent variable examined was that of the 

damping ratio, 𝜁𝜁.  This was done with 𝑅𝑅𝑅𝑅𝐷𝐷  = 1.14x106, 𝑡𝑡∗ = 0.0197, 𝐿𝐿∗ = 23.6, 𝜌𝜌∗ = 3.01, 

and 𝜔𝜔∗ = 0.473.  The results indicate a slight inverse relationship for all of the dependent 

variables as illustrated in Figure 6-15.  The data indicates that 𝛿𝛿∗ is proportional to 

𝜁𝜁−0.22, 𝑉𝑉∗ is proportional to 𝜁𝜁−0.51, and 𝐴𝐴∗ is proportional to 𝜁𝜁−0.35.  Power law curves fit 

the data very well with average relative error values of 2.8% for 𝛿𝛿∗, 3.6% for 𝑉𝑉∗, and 

4.6% for 𝐴𝐴∗. 

 

 

Figure 6-15 δ*, V*, and A* as functions of ζ for the long pipe model with ReD = 
1.14x106, t* = 0.0197, L* = 23.6, ρ* = 3.01, and ω* = 0.473 
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simply looking at the exponents for each of the power law curves fit to the data sets.  The 

values of these exponents are given in Table 6-3. 

 

Table 6-3 Summary of first order effects of all variables 

Variable Short Pipe Power Fit Exponents Long Pipe Power Fit Exponents 

 δ∗ V∗ A∗ δ∗ V∗ A∗ 

𝑅𝑅𝑅𝑅𝐷𝐷  -0.26 -0.30 -0.38 -0.20 -0.12 -0.18 

𝑡𝑡∗ -2.05 -1.96 -0.90 -1.16 -1.06 +0.04 

𝐿𝐿∗ - - - -0.72 -0.34 -0.16 

𝜌𝜌∗ - - - -1.00 -1.00 -1.00 

𝐸𝐸∗ or 𝜔𝜔∗ -1.00 -1.00 -1.00 -1.81 -0.67 +0.10 

𝜁𝜁 - - - -0.22 -0.51 -0.35 

 

 

6.4 Complete Functional Relationships 

All of the first order effects can be combined to generate a complete functional 

relationship for each of the dependant variables.  All of the dependencies have been fit 

using power relationships of the form 𝐷𝐷∗ ∝ 𝐴𝐴𝑖𝑖
𝑛𝑛𝑖𝑖 , where 𝐴𝐴𝑖𝑖  is the ith independent variable 

and 𝑛𝑛𝑖𝑖  is the ith power-fit exponent.  Multiplying each of the independent variables raised 

to the appropriate power results in a complete predictor of the dependant variable in 

terms of all independent variables.  The results of all of the simulations are compared to 

the complete functional relationship and plotted.  Each set of data is expected to be fit by 

a straight line through the origin.  A linear fit through the origin has an R2 value of at 

least 0.98 for all of the dependant variables for both the long and short pipe.  A plot of 𝛿𝛿∗ 
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versus its complete functional relationship including all independent variables for the 

short pipe model is shown in Figure 6-16 along with a linear fit line having average 

relative error of 14%.  A plot of 𝑉𝑉∗ versus its complete functional relationship including 

all independent variables for the short pipe model is shown in Figure 6-17 along with a 

linear fit line having average relative error of 11%.  A plot of 𝐴𝐴∗ versus its complete 

functional relationship including all independent variables for the short pipe model is 

shown in Figure 6-18 along with a linear fit line having average relative error of 21%.  A 

plot of 𝛿𝛿∗ versus its complete functional relationship including all independent variables 

for the long pipe model is shown in Figure 6-19 along with a linear fit line having 

average relative error of 7.6%.  A plot of 𝑉𝑉∗ versus its complete functional relationship 

including all independent variables for the long pipe model is shown in Figure 6-20 along 

with a linear fit line having average relative error of 6.3%.  A plot of 𝐴𝐴∗ versus its 

complete functional relationship including all independent variables for the long pipe 

model is shown in Figure 6-21 along with a linear fit line having average relative error of 

6.3%.  All of the full data sets are fit very well by straight lines intercepting the origin as 

expected. 

The full functional relationships represented on the x-axis of each of these plots 

constitute the most important contribution of this research.  These relationships describe 

the first-order contribution of each of the variables explored.  Higher order interactions 

between variables are not represented in the functional relationships presented here.  The 

functional relationships can be redimensionalized to allow one to pick out the specific 

contribution of each dimensional independent variable explored, but this exercise is not 

performed here. 
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Figure 6-16 δ* as a function of ReD
-0.26t*-2.05E*-1.00 for all short pipe model results 

 

 

 

Figure 6-17 V* as a function of ReD
-0.30t*-1.96E*-1.00 for all short pipe model results 
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Figure 6-18 A* as a function of ReD
-0.38t*-0.90E*-1.00 for all short pipe model results 

 

 

 

Figure 6-19 δ* as a function of ReD
-0.20t*-1.16L*-0.72ρ*-1.00ω*-1.81ζ-0.22    for all long pipe 

model results 
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Figure 6-20 V* as a function of ReD
-0.12t*-1.06L*-0.34ρ*-1.00ω*-0.67ζ-0.51    for all long pipe 

model results 

 

 

 

Figure 6-21 A* as a function of ReD
-0.18t*0.04L*-0.16ρ*-1.00ω*-0.10ζ-0.35    for all long pipe 

model results 
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6.5 Comparison to Experiments 

There is very little experimental data covering the wide range of variables explored 

in this research.  One of the primary goals of the numerical simulations was to cover a 

range of variables difficult to explore experimentally.  There have, however, been some 

experimental efforts to characterize turbulent pipe flow induced vibration.  Experimental 

data has primarily explored the effects of varying flow velocity.  Additionally, the effects 

of pipe material and thickness have been explored, but only for 2 or 3 different values.  

Experimental results obtained by Evans predict that pipe wall acceleration is proportional 

to approximately 𝑈𝑈2 [12].  Re-dimensionalizing the long pipe results presented in the 

previous section of this chapter results in a fluid velocity dependence of 𝐴𝐴′ ∝ 𝑈𝑈1.92.  This 

is very close to the value predicted by experiment.  It should also be noted that all 

experiments have used pipes with some degree of surface roughness.  The effect of 

surface roughness is to reduce Reynolds number dependence of the wall shear stress.  If 

the wall pressure fluctuations scale with shear stress as indicated by Figure 6-1, then the 

forcing function and pipe wall response would be expected to have less dependence on 

Reynolds number.  Removing the Reynolds number dependence (which is small anyway) 

from the relationships predicted from this research results in a fluid velocity dependence 

exponent of 2.1 which is in the range of values (1.94 to 2.19) determined by Thompson 

[30].   

Evans explored the use of 3 pipe materials over a range of flow rates from 7,000 to 

23,000 g/s with water as the working fluid.  The experimental pipes were all 3 inch 

(0.0762m) nominal diameter schedule 40 pipe made of PVC, aluminum, and stainless 

steel.  Water was used as the working fluid, and the pipe wall acceleration was measured 
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using an accelerometer.  Evans indicates that the experimental data from the PVC pipe is 

fit very well by the relation 𝐴𝐴′ = 2.98e-11 x Q2, where Q is the flow rate in grams per 

second.  The aluminum pipe data is fit by the same curve divided by a constant 1.2, and 

the steel pipe data is fit by the same curve as the PVC divided by a constant 2.2.  Evans 

proposes multiplying the data by �𝜌𝜌𝑃𝑃/𝜌𝜌𝑓𝑓 , where  𝜌𝜌𝑃𝑃 is the pipe material density and 𝜌𝜌𝑓𝑓  

is the fluid density, to collapse all three sets onto a single curve [12].  The present 

numerical simulations suggest that multiplying the data instead by 𝜌𝜌∗ will also cause the 

data to collapse since 𝐴𝐴∗ ∝ 1/𝜌𝜌∗.  Figure 6-22 shows a plot comparing the method used 

by Evans with the curve fit generated using the functional relationships from this 

research.  Both methods allow the data to be fit closely by a single curve, although the fit 

is slightly better with R2 = 0.998 for the method using 𝜌𝜌∗, compared to R2 = 0.993 for the 

method using �𝜌𝜌𝑃𝑃/𝜌𝜌𝑓𝑓 . 

 

 

Figure 6-22 Comparison to Evans experimental data 
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Thompson used only a single pipe material (PVC) for all experiments, but used 

both schedule 40 and schedule 80 pipe to determine the effects of varying thickness [30].  

The pipe wall acceleration was determined using an accelerometer and the fluid velocity 

was varied by controlling the speed of the driving pump.  The PVC test sections were 

isolated from the pump vibrations by sections of rubber pipe upstream and downstream 

of the test section.  Six sets of data are used here to check the numerical simulation, each 

corresponding to a different pipe test section.  Table 6-4 shows the geometry of each 

section used in the experiments performed by Thompson.  Water was the working fluid 

used for all of the experiments. 

 

Table 6-4 Thompson experiment pipe geometry 

Nominal Pipe Size Pipe Schedule Inner Diameter, 𝐷𝐷 Wall Thickness, 𝑡𝑡 

4 inch 40 0.1023 m 6.02 mm 

4 inch 80 0.0972 m 8.56 mm 

3 inch 40 0.0779 m 5.49 mm 

3 inch 80 0.0737 m 7.62 mm 

2 inch 40 0.0525 m 3.91 mm 

2 inch 80 0.0493 m 5.54 mm 

 

 

The numerical simulations suggest that 𝐴𝐴′ should be nearly inversely proportional 

to 𝑡𝑡∗ because 𝐴𝐴∗ ∝ 𝑡𝑡∗0.04.  Including the effects of varying 𝑡𝑡∗ and varying 𝜌𝜌∗ (which also 

changes with thickness) while neglecting the influence of Reynolds number, results in the 

prediction that 𝐴𝐴′ ∝ 𝑈𝑈2.1/(𝜌𝜌∗𝑡𝑡∗0.96).  A plot of the standard deviation of the pipe wall 

acceleration verses this prediction expression is shown in Figure 6-23.  The data for each 
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nominal pipe size is fit with a line passing through the origin resulting in a coefficient of 

determination of R2 = 0.95 for the 4 inch pipe data, R2 = 0.98 for the 3 inch data, and R2 

= 0.93 for the 2 inch data.  Each pair of data sets (schedule 40 and schedule 80) collapses 

to a straight line when accounting for changes in pipe wall thickness and average fluid 

velocity. 

 

 

Figure 6-23 Comparison to Thompson experimental data with linear fit 
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7 Conclusion 

7.1 Summary 

A numerical model of fully developed turbulent pipe flow based on LES has been 

developed and solved for 8 different Reynolds numbers.  The LES model has been 

verified and validated to ensure accuracy of the solutions obtained through its 

implementation.  The solutions from this fluid model have been used to approximate the 

fluctuating pressure field on the inside surface of a pipe.  This fluctuating pressure field 

has then been applied as external loads on the surface of a structural model of a segment 

of pipe.  The structural model using FEA has also been verified and validated.  The 

magnitude of the pipe wall motion due to the applied pressure fields has been explored 

for a range of pipe geometric and material property variables.  A complete set of non-

dimensional parameters that represents all of the variables explored has been used to 

generalize the results. 

The results indicate that there is a fundamental difference in the response of a short 

pipe compared to the response of a long pipe.  The short pipe responds immediately to 

changes in the pressure field and does not require the pipe inertia to be considered.  The 

short pipe tends to respond to local pressure variations and is more sensitive to changes in 

wall thickness than a long pipe.  The short pipe model indicates reduced response to 
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higher frequencies in the pressure fluctuations which correspond to smaller turbulence 

length scales.  The long pipe model is influenced by the pipe inertia and must include 

transient structural effects.  The long pipe tends to respond primarily by bending like a 

beam.  The long pipe also shows decreased response to the highest frequency small-scale 

pressure fluctuations, but also indicates heightened response at middle frequencies that 

correspond to the natural frequencies of the pipe.   

A functional relationship between 3 pipe motion dependant variables and 6 

dimensionless independent variables exerting influence has been developed by exploring 

first order effects of each variable.  The results can be summarized by these functional 

relationships as shown in Table 7-1.  These results were compared to available 

experimental data, and indicate that the numerical model used here has produced results 

with behavior similar to experiments. 

 

Table 7-1 Functional relationships: Result summary 

Short Pipe  
𝛿𝛿∗ ∝ 𝑅𝑅𝑅𝑅𝐷𝐷−0.26𝑡𝑡∗−2.05𝐸𝐸∗−1.0 

𝑉𝑉∗ ∝ 𝑅𝑅𝑅𝑅𝐷𝐷−0.30𝑡𝑡∗−1.96𝐸𝐸∗−1.0 

𝐴𝐴∗ ∝ 𝑅𝑅𝑅𝑅𝐷𝐷−0.38𝑡𝑡∗−0.90𝐸𝐸∗−1.0 

Long Pipe 
𝛿𝛿∗ ∝ 𝑅𝑅𝑅𝑅𝐷𝐷−0.20𝑡𝑡∗−1.16𝐿𝐿∗−0.72𝜌𝜌∗−1.0𝜔𝜔∗−1.81𝜁𝜁−0.22 

𝑉𝑉∗ ∝ 𝑅𝑅𝑅𝑅𝐷𝐷−0.12𝑡𝑡∗−1.06𝐿𝐿∗−0.34𝜌𝜌∗−1.0𝜔𝜔∗−0.67𝜁𝜁−0.51 

𝐴𝐴∗ ∝ 𝑅𝑅𝑅𝑅𝐷𝐷−0.18𝑡𝑡∗+0.04𝐿𝐿∗−0.16𝜌𝜌∗−1.0𝜔𝜔∗+0.10𝜁𝜁−0.35 
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7.2 Limitations 

The LES model used here is still limited by available computational resources.  The 

velocity profile of the highest Reynolds number flow explored is unable to be resolved 

fully near the wall.  The use of wall modeling adds additional approximations that result 

in somewhat inaccurate velocity profiles in this region.  The LES fluid domain is also 

short compared to many of the structural domains, requiring the pressure field to be 

repeated in the axial direction.  Any pressure imbalance in the field results in a net force 

that causes the pipe to bend.  This net force is effectively multiplied when the pressure 

field is repeated which may lead to larger bending motions than would exist for a model 

using a full-length fluid domain.  The solutions have been limited to 1000 time steps to 

reduce the computation time required for the fluid model.  While spatially averaged 

quantities become statistically steady within 1000 time steps, the local values of the wall 

shear stress and the standard deviation of pressure fluctuations are not statistically steady 

at 1000 time steps.  A longer solution (more time steps) would produce results with less 

noise. 

7.3 Recommendations 

In this thesis the first order effects of the variables of interest were explored.  It is 

recommended that additional research using this approach consider higher order effects 

by performing a more complete set of simulations that could be used to determine 

interaction between independent variables.  Future research could also use a longer fluid 

domain or more time steps to achieve more accurate results as additional computation 

power becomes available.  Combined efforts including experimental work could also be 
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used to develop an improved set of boundary conditions for the structural model, or a 

way to specify boundary conditions to model a particular experimental set-up for direct 

comparison of results.  The effect of pipe length has already been shown through this 

research to be heavily involved in complex effects, and could be the focus of future 

research using this type of model. 
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Appendix A 

Mesh Creation Instructions 

The mesh used for the fluid model was created using ANSYS® ICEM CFD™.  It is a 

utility intended strictly for generating meshes to be used for computational fluid 

dynamics (CFD) simulations.  The meshing program can import geometry from a variety 

of computer aided drafting (CAD) packages, or can be used to create geometry from 

scratch.  Because of the simple cylindrical geometry used here, the geometry is created 

directly in ICEM CFD™.  O-grid type blocking is then created to allow a higher quality 

mesh near the pipe wall.  Finally, the mesh parameters are set, and the mesh is generated 

and exported.  The steps for generating the fluid mesh using ICEM CFD™ are described 

below.   

A.1  Geometry 

The fluid domain consists of a cylinder that is 0.3 m long and 0.1015 m in diameter.  

A Cartesian coordinate system is used, with the x-dimension corresponding to the axis of 

the cylinder.  First a cylindrical surface is created using standard shapes or primitives 

(Geometry → Create/Modify Surface → Cylinder).  The first vertex is created at the 

point [0 0 0], and the second vertex is set to [0.3 0 0].  The radius is chosen to be D/2 or 

0.05075 m.  The circular edges at both the inlet and outlet are subdivided into four 
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segments using Geometry → Create/Modify Curve → Segment Curve to aid in the 

blocking process.  The cylindrical domain with subdivided edges is shown in Figure A-1. 

With the basic geometry in place the surfaces can be named and the fluid interior 

defined.  Display Tree → Parts → Create Part is used, and the surface on the yz plane 

is selected and named “Inlet.”  The process is repeated by selecting the surface opposite 

the inlet and renaming it “Outlet.”  Finally, the cylindrical surface is selected and 

renamed to “Wall.”  Creating these parts will allow different boundary conditions to be 

defined for each one when it comes time to start a simulation.  The fluid interior is 

created by using Geometry → Create Body.  The part name is changed to “fluid 

interior” or some other suitable name.  The Centroid of 2 points option is used, and the 2 

screen locations arrow is selected.  Any two points in the interior of the cylinder can be 

used, or a point on one side of the inlet and the opposite side of the outlet can be selected.  

This will define the solid region contained by all surfaces as the fluid region.  With the 

new parts created the Geometry → Repair Geometry → Build Diagnostic Topology 

tool is used with all default settings to remove any unused surfaces and points.  This step 

helps avoid any confusion when generating the blocking in the next steps. 
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Figure A-1 Basic geometry showing subdivided curves 

   

A.2  Blocking 

Once the geometry is done, a block is created and linked to the geometry.  This is 

done by creating a new block as a bounding box around the entire domain (Blocking → 

Create Block → 3D Bounding Box).  Associations are then defined such that each 

vertex of the block is associated with a point between adjacent segments of the curves at 

the inlet and outlet (Blocking → Associate → Associate Vertex).  This will result in the 

block becoming contained within the cylinder.  The edges of the block are then each 

associated with their respective nearest curved segment (Blocking → Associate → 

Associate Edge to Curve).  An image of the geometry with blocking is shown in Figure 
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A-2 with green arrows indicating edge associations.  The block is also resized by a factor 

of 1.7 in the y and z directions using the Blocking → Transform Blocks → Scale 

Blocks function.  At this point the block can be split using the Blocking → Split Blocks 

→ Ogrid Block function to allow superior grid properties at the pipe wall.  The block 

and the inlet and outlet surfaces must be selected for this operation to work correctly.  

After splitting there will be five separate blocks, with the four outside blocks allowing the 

grid to become perpendicular to the pipe wall while remaining uniform in the central 

region of the fluid defined by the inner rectangular block.  The resized block with O-grid 

split is shown in Figure A-3. 

 

Figure A-2 Block with edges associated to geometry 
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Figure A-3 Resized block split into sections using O-grid 

A.3  Mesh Parameters 

The Mesh → Surface Mesh Setup tool is used to apply arbitrary global mesh size 

parameters, but specific parameters are applied to selected edges under Blocking → Pre-

mesh Params → Edge Params.  The four edges parallel to the x-axis are selected and 

set to contain 180 nodes with Mesh Law set to uniform.  The eight outside edges (four 

around the inlet and four around the outlet) are then selected and set to contain 60 nodes 

with Mesh Law still set to uniform.  Finally, all of the radially oriented edges are 

selected and set to contain 30 nodes and Mesh Law set to From-Graphs.  A distribution 

that results in a finer mesh near the pipe wall is used.  The Pre-mesh is computed using 

Display Tree → Premesh → Recompute.  An end view of the mesh is shown in Figure 

A-4.  The mesh quality can be checked using the Pre-mesh Quality Histograms. 
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Figure A-4 Completed mesh as seen from the inlet end of the pipe 

A.4  Exporting Mesh for use in CFX® 

After verifying mesh quality by looking at properties such as skewness, angles, and 

2x2x2 determinant, the final mesh can be generated using Display Tree → Premesh → 

Convert to Unstruct Mesh.  The mesh generated using the steps described up to this 

point results in 1,879,920 nodes and 1,848,175 hexahedral elements.  The export format 

can be set by using Output → Select Solver → Ouput Solver.  There are over 100 

output solvers that may be selected here.  For the research presented in this thesis 

ANSYS CFX® is used as the fluid solver, so the ANSYS CFX option is selected.  Next, 

the Output → Write Input option is selected which causes a window to pop up with 

additional options such as mesh scaling.  The export file location is selected and the file 

is written. 
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Appendix B 

CFX Pre Instructions 

ANSYS CFX® uses three separate programs during a complete CFD solution.  It 

uses a pre-solver utility to set up the simulation, a solver utility to partition, run, and 

monitor the solution, and a post-processor to analyze the completed solution.  The 

program called CFX-Pre is used first to define the problem.  After beginning a new 

simulation, the previously constructed mesh can be imported by using File → Import 

Mesh.  The domain size and number of elements can be checked be selecting Outline → 

Mesh → Mesh Statistics to make sure the correct mesh has been imported.   

B.1  Simulation Setup 

The first step is to set the simulation type by selecting Insert → Simulation Type.  

A new tab will appear allowing the basic settings for the simulation type to be set.  For 

now the External Solver Coupling is set to None.  If the two-way coupling method is to 

be used than this field will need to be modified and will be explained further in the 

coupling chapter.  Simulation Type is set to Transient because the temporally varying 

pressure field is important.  The LES method can only be used in transient type 

simulations. Time Duration is set to Number of Timesteps per Run, and Num. of 

Timesteps is set to 5000.  This setting is used to allow the flow to progress to a fully 
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developed turbulent condition.  Approximately 5000 timesteps is sufficient to 

successfully achieve a fully developed condition as determined by monitoring wall shear 

stress during the solution.  The Time Steps field is set to Timesteps and then Timesteps 

is set at 0.001 s.  This gives an average Courant Number of about 0.6 for 1 m/s flow.  A 

Courant Number between 0.5 and 1.0 is suggested for LES simulations [19].  Using a 

higher value causes excess damping of the turbulence, while values lower than this take 

unnecessary extra time steps to achieve a converged solution.  The Initial Time field is 

set to Automatic with Value and Time is set to 0 s.  This final option allows the initial 

time to be adjusted to automatically match the last time step from a previous run if the 

simulation is being restarted. 

B.2  Boundary Conditions 

The next step to setting up the simulation is to define the boundaries and specify 

conditions at those surfaces.  Boundaries are created by using Insert → Boundary 

Condition, which will then bring up a prompt allowing the boundary to be named.  The 

first boundary is named “Wall” and a details tab appears next to Outline titled 

Boundary: Wall.  Choosing the boundary location is straight forward because of the part 

names selected when creating the mesh.  Under Boundary: Wall → Basic Settings → 

Boundary Type the Wall option is selected.  Location is also set to Wall.  Under 

Boundary: Wall → Boundary Details both the No Slip and Smooth Wall options are 

selected.  The Ok button is then selected to save the settings for the wall boundary.   

The inlet and outlet are set as a periodic boundary, which allows the flow to continue 

back in the inlet as it is exiting the outlet.  This condition simulates a long pipe where the 
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flow is allowed to reach a fully-developed state.   The periodic condition is specified by 

first creating a domain interface by using Insert → Domain Interface.  After selecting a 

name for the interface (“Domain Interface 1” is the default name and is used here) a new 

tab appears next to Outline which contains the basic settings for the interface.  The first 

field, Interface Type, is set to Fluid Fluid.  The domain interface contains two fluid 

surfaces called “Domain Interface Side 1” and Domain Interface Side 2.”  Region List 

for Side 1 is set to Inlet, and region list for Side 2 is set to Outlet.  This identifies the 

inlet and outlet as a common boundary where the flow properties will be matched.  The 

Interface Models option is set to Translational Periodicity to indicate straight flow 

through the pipe.  The Mass And Momentum box is checked to allow the mass flow rate 

through the interface to be specified.  For water with an average flow velocity of 1 m/s 

the mass flow rate is set to 8.068 kg/s.  The Ok button is selected to save the domain 

interface settings.  The appearance of curved arrows at the pipe ends as seen in Figure 

B-1 indicates the successful creation of the periodic interface. 



112 

 

Figure B-1 CFX-Pre fluid domain showing periodic boundary 

B.3  Fluid Domain 

In order to define the conditions and settings for the fluid domain, a material must 

be specified.  CFX® does include some predefined materials, but a user specified material 

allows more flexibility.  The basic set of simulations for obtaining varying Reynolds 

Number all use water as the working fluid and vary the flow velocity.  Verification of the 

non-dimensional solution, however, required modifying certain fluid properties 

independently of all others.  A user material is defined by selecting Insert → Material 

and then choosing a name for the material (the default for the first new user material is 

“Material 1”).  Under the Basic Settings tab for the material a brief description can be 

inserted, the material phase can be specified, and complex options can be set for reacting 

flows and mixtures.  For these simulations the Option field is left as Pure Substance.  

Under the Material Properties tab the Option field is left as General Material to allow 
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the user to specify all of the properties directly.  The material properties tab has a section 

titled Thermodynamic Properties.  In this section, leaving the Equation of State → 

Option field set to Value allows constant properties to be specified.  For this research 

compressibility effects are not considered, so using a constant density fluid is appropriate.  

The Density field is set at 997 kg/m3 for most of the simulations, but can be varied to 

verify the non-dimensional solution.  The Molar Mass field is not used because the flow 

is not reacting.  Specific Heat Capacity is also not used because heat transfer is not 

considered important in these simulations and again, compressibility effects are ignored.  

The Reference State and Table Generation fields under Material Properties → 

Thermodynamic Properties are not used.  Clicking the plus sign next to Material 

Properties → Transport Properties will expand the field to include additional options.  

A check mark must be placed next to Dynamic Viscosity to allow editing of the field.  

The Option portion is set to Value to use a constant viscosity.  The Dynamic Viscosity 

portion of the field is then set for most simulations at 0.0008899 N∙s/m2 but, like other 

properties, can be modified.  The Thermal Conductivity property is not set and the 

remaining two fields, Radiation Properties and Buoyancy Properties, do not need to be 

expanded.  The Ok button is finally selected to save the changes and close the Material 

Properties tab. 

After specifying the settings for the new material, the fluid domain can be set up by 

selecting Insert → Domain.  This will bring up a prompt to name the domain (the name 

“fluid” is used for simplicity and clarity) and a new tab titled Domain: fluid.  This tab 

will have three sub-tabs, General Options, Fluid Models, and Initialization.  First, 

under Domain: fluid → General Options → Basic Settings, the Location field needs to 
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be set to the named interior portion of the mesh (“fluid interior” was used when creating 

the mesh).  Domain Type is set to Fluid Domain, and the user created material, 

Material 1, is selected under Fluids List.  The default coordinate frame, Coord 0, is left 

selected under Coord Frame (this is the same Cartesian frame used for the mesh).  The 

last Basic Settings field is for adding solid particles or bubbles to the fluid.  No particles 

are used in these simulations so Particle Tracking is left turned off.  Domain: fluid → 

General Options → Domain Models requires a fixed pressure to use as a reference.  All 

pressures determined in the solution will be gauge pressures relative to this reference.  

Reference Pressure is set to 101 kPa.  The other options under Domain Models are not 

used unless a non-inertial frame is being considered.   

The next settings for the fluid domain are specified under the sub-tab Domain: 

fluid → Fluid Models.  Because heat transfer is not being considered, the Heat Transfer 

→ Option can be set to None and will reduce computation time.  Turbulence → Option 

is set to LES Smagorinsky, which will greatly increase computation time, but is required 

in order to resolve the pressure fluctuations characteristic of turbulent flow.  Turbulence 

→ Wall Function is set to Automatic.  This will let the solver decide whether to use 

scalable wall functions depending on the fineness of the mesh near the wall and the 

dimensionless wall shear stress.  The plus sign by Turbulence → Advanced Control 

needs to be clicked to expand additional options.  The Smagorinsky closure model for 

LES requires a single parameter called the Smagorinsky constant which is used to 

determine the sub grid scale (SGS) viscosity.  The value of Turbulence → Advanced 

Control → Smagorinsky Model Constant is therefore set to 0.1 after checking the box 
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next to this field.  The Reaction or Combustion and Thermal Radiation Model are left 

set at None. 

The final sub-tab under the fluid domain settings is Domain: fluid → 

Initialization.  Because LES modeled flows are time accurate they require proper initial 

conditions.  The flow field for these simulations is allowed to develop to a statistically 

steady state where statistical values are independent of the initial conditions, but the flow 

must be disturbed to allow turbulent structures to develop.  This is done by initializing the 

flow field with random velocity fluctuations superposed on a uniform profile.  The 

Domain Initialization box must be checked to make new options available.  Velocity 

Type is left set to Cartesian, and Cartesian Velocity Components → Option is set to 

Automatic With Value.  The U is set to 1, while V and W are set to 0.  The Cartesian 

Velocity Components → Velocity Fluctuation box needs to be checked to add 

perturbations and Velocity Fluctuation is set to 0.1.  Finally Static Pressure → Relative 

Pressure is set to 0 and the Ok button is clicked to save changes. 
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Appendix C 

CFX-Post Pressure Export Script 

After a fluid simulation is complete, with the pressure saved at each time step, the 

modified pressure needs to be calculated and exported for use in the structural 

simulations.  Below is a CFX Command Language (CCL) code that can be used for this 

exporting step.   It is used by saving the code in a text file with the extension ‘.cse’.  The 

lines dealing with the export folder location must be updated to reflect the location where 

the comma delimited data files will be exported to.  CFX-Post must be open and the 

results file from the fluid simulation must be loaded.  Finally, the CCL code can be 

executed by choosing Session → Play Session, and selecting the previously saved .cse 

file. 

 
 
 
####################################################################### 
# This CCL file can be run in ANSYS CFX-Post following the completion  
#   of the transient flow solution to extract the pressure for use in  
#   a FEA model.        
# Author: Thomas Shurtz        
# Revised: 03/20/09        
####################################################################### 
 
 
COMMAND FILE: 
  CFX Post Version = 11.0 
END 
 
SCALAR VARIABLE:Pressure 
  Boundary Values = Hybrid 
  User Units = Pa 
END 
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####################################################################### 
# Calculates the modified pressure by subtracting of the volume average 
####################################################################### 
LIBRARY: 
  CEL: 
    EXPRESSIONS: 
      Padj=Pressure - volumeAve(Pressure)@Default Domain 
    END 
  END 
END 
EXPRESSION EVALUATOR: 
  Evaluated Expression = Padj 
END 
> forceupdate EXPRESSION EVALUATOR 
 
 
##################################################### 
# Calculates the angular position of all of the nodes 
##################################################### 
LIBRARY: 
  CEL: 
    EXPRESSIONS: 
      Theta=atan2(Y,Z) 
    END 
  END 
END 
EXPRESSION EVALUATOR: 
  Evaluated Expression = Theta 
END 
> forceupdate EXPRESSION EVALUATOR 
 
 
########################################################## 
# Creates the new variables to store the calculated values 
########################################################## 
USER SCALAR VARIABLE:P2 
  Boundary Values = Conservative 
  Calculate Global Range = Off 
  Expression = Padj 
  Recipe = Expression 
  Variable to Copy = Pressure 
END 
USER SCALAR VARIABLE:Angle 
  Boundary Values = Conservative 
  Calculate Global Range = Off 
  Expression = Theta 
  Recipe = Expression 
  Variable to Copy = Pressure 
END 
 
 
############################################################# 
# Set to the first time step and export the modified pressure 
#   and angle at each node 
############################################################# 
> load timestep=0 
 
EXPORT: 
  ANSYS Export Data = Element Heat Flux 
  ANSYS Reference Temperature = 0 [K] 
  ANSYS Specify Reference Temperature = Off 
  ANSYS Supplemental HTC = 0 [W m^-2 K^-1] 
  BC Profile Type = Inlet Velocity 
  Export Connectivity = Off 
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  Export Coord Frame = Global 
 
  ############################### 
  # Set 1st export file name here  
  ############################### 
  Export File = G:/Research/export/1ms/0.csv  
   
  Export Geometry = on       
  Export Node Numbers = Off 
  Export Null Data = Off 
  Export Type = Generic 
  Export Units System = Current 
  Export Variable Type = Hybrid 
  Include File Information = Off 
  Include Header = Off 
  Location List = Wall 
  Null Token = 0 
  Overwrite = Off 
  Precision = 8 
  Separator = ", " 
  Spatial Variables = X,Y,Z 
  Variable List = Angle, P2 
  Vector Brackets = () 
  Vector Display = Scalar 
END 
>export 
 
############################################################# 
# Loops through all remaining time steps and exports the data 
#   Don't forget to change the export folder 
############################################################# 
!for ($i=1; $i < 1000; $i++) { 
 > load timestep=$i 
 EXPORT:       
   Export File = G:/Research/export/1ms/$i.csv 
 END 
 >export 
!} 
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Appendix D 

Matlab Code for Pressure Mapping 

The modified pressure data from the comma delimited files must be reduced to 

match the structural mesh node locations.  This Matlab code was written to import the 

pressure data time step by time step and write a corresponding load file for each one.  The 

load step files can be imported into ANSYS during the structural simulations. 

 

% This program creates CDB load files for an ANSYS simulation. 
% It reads pressure data from CFD simulations and averages over 
% 25 nodes to reduce the number of load application point by a  
% factor of 4 in each directionand determines the force components. 
% It then prints F commands to apply the forces to the ANSYS model 
% nodes. 
% The program can be broken into two parts - the pressure reading part 
% which was originally created just to put the pressure data into a 
% single array - and the area averaging and CDB file generation part, 
% which can be run stand-alone if the pressure data array is already 
% available in the current workspace. 
% Author: Thomas Shurtz 
% Revised: 06/01/2009 
  
clear all 
  
% Sets the geometric parameters - change these if needed 
D = .1015;  % Pipe Diameter 
L = 0.3;    % Pipe Length 
I = 236;    % Number of circumfrential pressure locations 
J = 180;    % Number of axial pressure locations 
I2 = I/4;   % Number of new circumfrential locations 
J2 = J/4;   % Number of new axial locations; 
  
% Calculates the discretization size and element area 
dw = D*pi/I; 
dl = L/(J-1); 
A = dw*dl; 
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% This loop goes through each time step and extracts the pressure 
first = 0;  %First file number in case offset is needed in file naming 
for k = first:first+999 
     
    % This is the location of the pressure data - change if needed 
    D =importdata(strcat('G:\Research\export\1ms\',int2str(k),'.csv')); 
     
    % Gets the pressure data sorted for consistancy in node numbers 
    D = sortrows(D,[1 4]);           
    for j = 1:J 
        D(I*j-I+1:I*j,6)= j; 
    end 
    D = sortrows(D,[6,4]); 
    
    for j = 1:J 
        P(j,:) = D(I*j-I+1:I*j,5); 
    end 
    Pressure(:,:,k-first+1) = P; % Saves the pressure data in an array 
end 
% This completes the pressure reading portion 
  
  
  
% This begins the CDB file creation portion 
% Figures the average pressure drop 
x = (0:L/(J-1):L)'; 
fit = polyfit(x(3:J-2),mean(mean(Pressure(3:J-2,:,:),3),2),1); 
drop = fit(1)*L; 
  
% Calculates angular coordinates of all the nodes 
for i = 1:I2 
    theta(i) = -pi+(i-1)*2*pi/I2+2*pi/I2-pi/I; 
end 
        
  
% Uses the pressure data to calculate the nodal forces at each timestep 
% and print it into the file as an F command 
for k = 0:999 
     
    P = Pressure(:,:,k+1); 
     
    % Fixes the bad pressure data at the pipe ends 
    P(1,:) = P((J-1),:)+(P(3,:)+drop-P(J-1,:))/3-drop; 
    P(2,:) = P((J-1),:)+2*(P(3,:)+drop-P(J-1,:))/3-drop; 
     
    % Repeats the pressure axially for the long pipe model 
    for i = 1:8 
        P((i-1)*(J-1)+1:i*(J-1)+1,:) = P+drop*(i-1);        
    end 
     
    % Creates overlap at the edges to allow consistant averaging loop 
    clear P2; 
    P2(:,3:I+2) = Pf; 
    P2(:,1:2) = Pf(:,I-1:I); 
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    P2(8*J-6,:) = P2(8*J-8,:); 
    P2(8*J-5,:) = P2(8*J-9,:); 
    P2(3:8*J-3,:) = P2; 
    P2(1,:) = P2(5,:); 
    P2(2,:) = P2(4,:); 
  
    % Area averages the pressure using 5x5 overlaping regions 
    for j = 1:J2 
        for i = 1:I2 
            Pn(j,i) = sum(sum(P2(j*4-2:j*4,i*4-2:i*4)))... 
            +(sum(P2(j*4+1,i*4-2:i*4))+sum(P2(j*4-3,i*4-2:i*4)))/2 ... 
            +(sum(P2(j*4-2:j*4,i*4+1))+sum(P2(j*4-2:j*4,i*4-3)))/2 ... 
            +(P2(j*4-3,i*4-3)+P2(j*4-3,i*4+1)+P2(j*4+1,i*4-3)... 
            + P2(j*4+1,i*4+1))/4; 
        end 
    end 
     
    % Calculates the force components from the pressure    
    for j = 1:J2 
        Fn2((j-1)*I2+1:j*I2,1) = Pn(j,:).*sin(theta)*A; 
        Fn2((j-1)*I2+1:j*I2,2) = Pn(j,:).*cos(theta)*A; 
    end 
     
    % This is the location for the new CDB files - change if needed 
    newfile = strcat('G:\Research\Forces\1ms\'... 
        ,int2str(k-first),'.cdb'); 
       
    % Prints the F commands for all of the forces line by line 
    fidw = fopen(newfile, 'wt'); 
    for i = 1:I2*J2 
        fprintf(fidw,'%s',strcat('F,',int2str(i),',FY,')); 
        fprintf(fidw,'%+17.9e\n',Fn2(i,1)); 
        fprintf(fidw,'%s',strcat('F,',int2str(i),',FZ,')); 
        fprintf(fidw,'%+17.9e\n',Fn2(i,2)); 
    end 
    fclose(fidw); 
    k 
        
end 
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Appendix E 

Matlab Code for Creating Nodes and Elements for Structural Model 

Because the CDB load files apply the forces at numbered nodes, it is important for 

the node numbering of the structural model to be consistent.  This Matlab code is used to 

write a file that, when imported by ANSYS, will create the pipe geometry and elements 

with node numbers ordered correctly to accept loads from the CDB files created using the 

code in Appendix D.  The file generated by this code is intended to be imported using the 

ANSYS batch file in Appendix F. 

 

 

% This program generates an input file that will create 
% nodes and shell63 elements on a cylindrical surface for use in 
% an ANSYS model.  The variable definition portion of the code 
% must be modified to include the desired geometric parameters. 
% Author: Thomas Shurtz 
% Revised: 06/01/2009 
  
clear all 
  
% Create a new file - choose the file name and location 
newfile = 'G:\Research\Forces\1ms\Elements.cdb'; 
fidw = fopen(newfile, 'wt'); 
  
  
% Define the geometric parameters 
I = 59;         % Number of circumfrential nodes 
J = 359;        % Number of axial nodes  
L = 2.4;        % Length 
D = 0.1015;     % Diameter 
dT = 2*pi/I;    % calculates the angular node spacing 
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% These loops define the corner nodes for each element 
for i = 1:I*(J-1) 
    E(i,:) = [i i+I i+I+1 i+1]; 
end 
for i = I:I:I*(J-1) 
    E(i,3:4) = E(i,3:4)-I; 
end 
  
% This loop defines the axial and angular coordinate of each node 
for i = 1:J 
    N(i*I-I+1:i*I,1) = L*(i-1)/(J-1)*ones(I,1); 
    N(i*I-I+1:i*I,2) = (-pi:dT:pi-dT)'+ dT - dT/8; 
end 
  
% This converts the angular coordinate into y and z location 
N(:,3) = D/2*sin(N(:,2)); 
N(:,4) = D/2*cos(N(:,2)); 
  
% Prints the first text lines to the file to apply material properties 
fprintf(fidw,'%s\n',':CDWRITE');  
fprintf(fidw,'%s\n','/PREP7'); 
fprintf(fidw,'%s\n','wprota,,,90'); 
fprintf(fidw,'%s\n','ET,1,SHELL63'); 
fprintf(fidw,'%s\n','R,1,thick'); 
fprintf(fidw,'%s\n','MP,EX,1,modulus'); 
fprintf(fidw,'%s\n','MP,PRXY,1,poiss'); 
fprintf(fidw,'%s\n','MP,DENS,1,density'); 
fprintf(fidw,'%s\n','MP,DAMP,1,damping'); 
fprintf(fidw,'%s\n','/NOPR');  
fprintf(fidw,'%s\n','IMME,OFF'); 
fprintf(fidw,'%s\n','NBLOCK,6,SOLID'); 
fprintf(fidw,'%s\n','(3i8,6e17.9)'); 
  
% Prints the node locations 
for i = 1:I*J 
fprintf(fidw,'%8d',i); 
fprintf(fidw,'%8d',0); 
fprintf(fidw,'%8d',0); 
fprintf(fidw,'%+17.9e',N(i,1)); 
fprintf(fidw,'%+17.9e',N(i,3)); 
fprintf(fidw,'%+17.9e\n',N(i,4)); 
end 
  
% Sets up for element creation with EBLOCK command 
fprintf(fidw,'%s\n','N,R5.3,LOC,   -1,'); 
fprintf(fidw,'%s\n',strcat('EBLOCK,19,SOLID,   ',int2str(I*(J-1)))); 
fprintf(fidw,'%s\n','(19i8)'); 
  
% Prints the element numbers and which nodes they are between 
for i = 1:I*(J-1) 
fprintf(fidw,'%8d',1); 
fprintf(fidw,'%8d',1); 
fprintf(fidw,'%8d',1); 
  
    for j = 1:5 
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        fprintf(fidw,'%8d',0); 
    end 
    fprintf(fidw,'%8d',4); 
    fprintf(fidw,'%8d',0); 
    fprintf(fidw,'%8d',i); 
    for j = 1:3 
        fprintf(fidw,'%8d',E(i,j)); 
    end 
    fprintf(fidw,'%8d\n',E(i,4)); 
end 
fprintf(fidw,'%-d\n',-1); 
  
% Closes the file 
fclose(fidw); 
 

 

 

  



128 

  



129 

Appendix F 

ANSYS Batch File Used to Define and Run Structural Simulations 

The structural simulations require the solver settings to be specified and the CDB 

file that creates the elements to be imported.  They also require the changing load files to 

be imported each time step to update the fluid pressure induced loading.  This batch file 

can be used as a template to define and run structural simulations. 

 

 

 

 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
! This batch file is used to set up and run ANSYS transient 
! simulations for the long pipe model. Only minor modification 
! is required to make it suitable for the short pipe model 
! Author: Thomas Shurtz 
! Revised: 06/01/2009 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
 
 
! Define Parameters 
 
*SET,or,.05075                  ! Pipe Inside Diameter 
*SET,h,2.4      ! Pipe Length  
*SET,thick,0.002  ! Pipe Wall Thickness 
*SET,density,3000  ! Pipe Density 
*SET,modulus,70000000000 ! Pipe Elastic Modulus    
*SET,poiss,0.3   ! Poisson's Ratio 
*SET,damping,.001  ! Material Damping Coefficient 
*SET,L,2.4   ! Clamping Distance 
*SET,TS,.0001   ! Time step size 
 
 
! Import the element file to create the nodes and elements 
 
/input,G:\Research\Forces\Elements,cdb 
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! Set the boundary conditions (Aditional fixed nodes must be  
!   added for reduced clamping length simulations) 
 
d,15,ux,0 
d,15,uy,0 
d,15,uz,0 
d,44,uz,0 
d,21078,uy,0 
d,21078,uz,0 
 
 
! Import the first load file 
 
/NOPR 
/input,G:\Research\Forces\1ms\0,cdb 
finish 
 
 
! Enter the solver and specify the settings 
! The first step is solved as steady to get initial position 
 
/solu 
time,TS 
deltim,TS/2 
antype,trans 
timint,off,all 
rescontrol,define,none 
kbc,1 
nsubst,2 
OUTRES,erase 
OUTRES,all,none 
OUTRES,svar,none 
OUTRES,loci,none 
OUTRES,NSOL,last 
OUTRES,V,last 
OUTRES,A,last 
solve 
 
 
! Turn tim integration on for all other time steps 
timint,on,all 
nsubst,1 
 
 
! Loop through each time step, updating forces at each one 
 
*DO,jj,2,1000 
fdele,all 
/NOPR 
/input,G:\Research\Forces\1ms\%jj-1%,cdb 
time,.001*(jj) 
solve 
save 
*ENDDO 
finish 
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